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About This Book

This book describes how to install and use Work Management Builder, which is part of
IBM ImagePlus Workfolder Application Facility for AS/400 (Workfolder Application
Facility), which is a feature of the IBM ImagePlus Visuallnfo for AS/400 (Visuallnfo for
AS/400) licensed program. You can use Work Management Builder to create a
graphical representation of a work process, define workbaskets, and describe the
actions that a user can perform. This book also explains how to install use the Work
Management Builder online tutorial.

Work Management Builder lets you create work processes using a graphics-based
editor instead of the character-based panels in Workfolder Application Facility. For more
information on how Workfolder Application Facility uses action lists, workbaskets, and
work processes, refer to the IBM ImagePlus Workfolder Application Facility for AS/400:
User’s Guide.

Who Should Use This Book

This book can help a system administrator or business process owner define work
processes for Workfolder Application Facility on a workstation. It explains how to use
the Work Management Builder and how it works with Workfolder Application Facility.

You should also be familiar with the following:
¢ IBM-compatible workstations
¢ |IBM Operating System/2 (OS/2)

e Workfolder Application Facility work management concepts (refer to the /IBM
ImagePlus Workfolder Application Facility for AS/400: Planning and Installation
Guide and the IBM ImagePlus Workfolder Application Facility for AS/400: User’s
Guide)

In addition, if you are installing Work Management Builder, you must be familiar with
Personal Communications (PCOMM) and related workstation configurations.

How This Book Is Organized
This book contains the following information.

e Chapter 1, “Introducing Work Management Builder” on page 1 explains how Work
Management Builder works with Workfolder Application Facility. It also describes
how to design a work process.

e Chapter 2, “Installing Work Management Builder” on page 7 provides step-by-step
instructions for installing Work Management Builder and also explains how to
delete it.

e Chapter 3, “Getting Started” on page 19 explains the basic components of Work
Management Builder windows, how to open and close Work Management Builder,
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and how to log on and off Workfolder Application Facility from within Work
Management Builder.

¢ Chapter 4, “Using Work Management Builder Objects” on page 26 describes
different ways to work with objects in Work Management Builder container
windows, including opening objects, copying objects, and checking objects in and
out of Workfolder Application Facility.

¢ Chapter 5, “Working with Action Lists” on page 36 explains how to create action
lists and how to work with existing action lists.

e Chapter 6, “Working with Workbaskets” on page 42 explains how to create
workbaskets and how to work with existing workbaskets.

e Chapter 7, “Working with Work Processes” on page 51 explains how to create
work processes and how to work with existing work processes.

e Chapter 8, “Using the Work Process Window” on page 56 explains how to use the
work process editor to create a graphical representation of a work process.

¢ Appendix A, “Using the Work Management Builder Tutorial” on page 89 explains
how to use the Work Management Builder online tutorial.

¢ Appendix B, “Defining Function Keys and Options” on page 97 describes the
function keys and options available for index and work action lists.

Where to Find More Information

The following IBM documents contain information that you might find helpful when using
Visuallnfo for AS/400.

For a list of other related publications, see “Bibliography” on page 100. Request copies
of IBM publications from your IBM representative or from the IBM branch office serving
your area.

IBM ImagePlus Visuallnfo for AS/400

When you order Visuallnfo for AS/400, you receive the following printed publications as
part of the Visuallnfo for AS/400 license.

e IBM ImagePlus Visualinfo: Client for Windows User’s Guide, SC31-9052

e IBM ImagePlus Visuallnfo for AS/400: Licensing Information, GC34-4589

e IBM ImagePlus Visuallnfo for AS/400: Planning and Installation Guide, GC34-4585
e IBM ImagePlus Visuallnfo for AS/400: System Administration Guide, GC34-4583

The remaining books are shipped in softcopy format only.
e IBM ImagePlus Visuallnfo: Messages and Codes, SC31-9065

e IBM ImagePlus Visuallnfo for AS/400: Application Programming Guide and
Reference, SC34-4586
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IBM ImagePlus Workfolder Application Facility for AS/400
When you order the Workfolder Application Facility feature of Visuallnfo for AS/400, you
also receive the following printed publications.

e IBM ImagePlus Workfolder Application Facility for AS/400: Planning and Installation
Guide, GC34-4624

e IBM ImagePlus Workfolder Application Facility for AS/400: System Administration
Guide, GC34-4625

The remaining books are shipped in softcopy format only.

e IBM ImagePlus Workfolder Application Facility for AS/400: Designing a Work
Process, SC34-4588

e IBM ImagePlus Workfolder Application Facility for AS/400: Programming Interfaces
Guide, SC34-4590

e IBM ImagePlus Workfolder Application Facility for AS/400: User’s Guide,
SC34-4584

e IBM ImagePlus Workfolder Application Facility for AS/400: User’s Guide for the
Work Management Builder, SC34-4587

About the Softcopy Document Library
In addition to the printed books you receive as part of the Visuallnfo for AS/400
product, the entire document library is available in softcopy. Shipped on a separate
document tape or CD-ROM, the library includes books for the Workfolder Application
Facility feature. You can also purchase printed copies of any book in the library.

The library is available in the following formats:
e Portable document format (PDF)

e Hypertext markup language (HTML)

Before you can view or print PDF and HTML documents, follow the installation
instructions in either the IBM ImagePlus Visualinfo for AS/400: Planning and Installation
Guide or IBM ImagePlus Workfolder Application Facility for AS/400: Planning and
Installation Guide.

PDF Files
Using PDF files, you can easily view documents online, as well as select one or more
pages that you want to print.

To view PDF documents, you must have a Web browser and the Adobe Acrobat

Reader. If you do not already have this tool, you can obtain it free by following the
instructions for download from the Adobe home page:

http://www.adobe.com/prodindex/acrobat/readstep.html
A variety of national language readers are also available.

Using the Adobe Acrobat Reader, you can do the following:

¢ View documents that resemble printed pages.
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¢ Easily navigate through PDF books as you would a hardcopy document.

¢ Use the text search capability by selecting Find from the Tools pull-down menu.
e Easily print a single page, a range of pages, or an entire document.

e Customize page size, graphics, fonts, and font sizes.

To view or print books from PDF files using the Adobe Acrobat Reader, follow these
steps.

1. Start the Adobe Acrobat Reader.

2. Select Open from the File pull-down menu.

3. Select the location where you installed the document library.
4. Select the book you want to view.

HTML Files

Using HTML files, you can use a Web browser of your choice to view and print HTML
books. These resemble printed books yet provide convenient HTML links to help you
navigate through the information.

To view or print books from HTML files, follow these steps.

1. Start your Web browser.

2. Select the Open or Open file choice (usually from the File pull-down menu).
3. Select the location where you installed the document library.

4. Select the book you want to view.

BookManager Files

BookManager files for the Visuallnfo for AS/400 document library will be available in the
first half of 1998 on CD-ROM as part of the AS/400 softcopy collection kit. To view or
print books using BookManager, refer to the books that accompany your softcopy
collection Kkit.
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Chapter 1. Introducing Work Management Builder

Work Management Builder is part of the IBM ImagePlus Workfolder Application Facility
for AS/400 (Workfolder Application Facility) feature of the IBM ImagePlus Visuallnfo for
AS/400 (Visuallnfo for AS/400) licensed program. Work Management Builder lets you
use a workstation to create a graphical representation of a work process and define the
workbaskets and action lists that support it.

Workfolder Application Facility is an interactive program that lets you enter and work
with document images and manage the flow of work. You can use the graphical user
interface (GUI) of Work Management Builder instead of the Workfolder Application
Facility character-based panels to create a work process and integrate it into the flow of
work.

Understanding Work Management

Most business operations can be characterized as a set of interrelated processes. Work
flows from one employee to another, and from one department to another. Some simple
processes might require only a few steps, while more complex processes involve a
number of employees in different departments.

Work management lets you move work through a process, gather documents at
collection points, and monitor work throughout the process. For example, a mortgage
loan company receives large volumes of loan applications in the mail. During the
approval process, the company receives follow-up documents such as credit reports
and appraisals. Employees spend several hours each day opening, sorting, filing, and
monitoring applications, as well as collecting pertinent documents for final approval.

Documents are moved from one employee to another as they are received and
checked. As the loan package is completed, it might be handled by employees in more
than one department.

Understanding Work Processes

As in the mortgage loan company example, most enterprises that handle documents
perform some or all of the following tasks:

¢ File documents for later retrieval

e Collect documents, forms, and information from different sources, then deliver
these documents somewhere to be processed

¢ Match incoming mail with documents currently being processed
¢ Hold some work until another department or group is finished with its part of the
work.

A work process represents the flow of work in Workfolder Application Facility. It
describes the actions that can be performed on a group of one or more documents and
the path that this group takes through the work management process.

© Copyright IBM Corp. 1993, 1997 1



A work process reflects work the way that it is performed, with a clearly defined scope
and boundaries. It defines the sequence of activities and tasks, and the connections
and relationships among those activities and tasks. A work process determines the
criteria that are used to make decisions on the flow of work and the points at which
those decisions are made.

Planning a Work Process

Before you begin to define a work process, you must determine the work that your
business performs, in addition to where and how it is performed.

What is the final product? The final product might be the result of all the work
accomplished by your business, by one department in your business, or by certain
employees from different departments. For example, the final product of the mortgage
loan company is the letter sent to the applicant approving or rejecting the loan
application.

Analyze the information that must be processed to produce the final product, determine
the actions that must be performed and where they are performed, and decide how you
want the information to flow through the work management process.

Information to be Processed

Consider the information that must be handled. What types of input support the final
product? What are the specific documents that must be processed?

A work package consists of zero or more documents that can be moved together from
one place to another in a work process. For example, a mortgage loan company initially
receives loan applications and later receives follow-up documents, such as credit
reports and appraisals. These documents form the work package.

How Information is Handled
Who can best handle each step of the process? For example, a loan officer might verify
that a loan application is complete, then file the application until a certain document is
received from the applicant. When the document arrives, the loan officer might be
responsible for matching the document with the application, as well as for processing
that document.

The loan applications could be grouped in a workbasket that is accessible to a number
of loan officers. A workbasket is a point in the process where work packages are
handled. Workbaskets could be defined within the work process to handle each part of
the loan process, such as credit reports and home appraisals.

For more information on using workbaskets, see Chapter 6, “Working with
Workbaskets” on page 42.
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Actions to be Taken
Consider what actions must be taken on the contents of a workbasket. For example, a
loan officer can accept an application or reject it as incomplete. An action list defines
the actions that a user can perform on the work package. An action list can describe
the following:

¢ Predefined function keys
e Customer-defined function keys
e Selectable options that are available to the user

Depending on whether an application meets the initial credit requirements, a loan officer
could select one predefined function key to continue the application through the work
process, or another function key to reject the application (for example, F2 to accept or
F8 to reject).

When a user works with a workbasket in Workfolder Application Facility, only those
actions that you have previously defined for the work package at the workbasket are
available.

For more information on using action lists, see Chapter 5, “Working with Action Lists”
on page 36.

How Information Flows Through the Process
Consider how you want information to flow through your process. For example, when is
the initial loan application reviewed? What supporting documents are needed to move
on to the next step in the process? What criteria determine whether an application is
accepted or rejected? This flow of information is the basis of your work process, which
defines the way users perform their work. A work process consists of decision points,
collection points, and the paths that guide the work throughout processing.

Where does the input originate? Your work process must begin at some point. In the
mortgage loan company, the loan application, submitted by the applicant, is the
document that starts the work process.

Decision points determine the path of the work based on a set of values you specify.
For example, a loan application can be rejected if the applicant's salary is insufficient.
Collection points manage work packages that need to wait for additional documents,

the completion of another action, or the occurrence of business events. For example,
the loan application cannot be approved or rejected until the credit report is received

and processed.

One decision point in the mortgage loan example might move an application to a
collection point to wait for credit reports and appraisals. You can assign time guidelines
to the collection points to wait for documents and continue them along the path when
they arrive, or signal that a document has not been received. For example, if a credit
report is valid for a certain length of time, the collection point might wait that length of
time for other supporting documents, such as a home appraisal, after it receives a
credit report.
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Processes within a workbasket can continue along parallel paths to several collection
points at one time. In this way, documents that arrive at different times do not affect
other parts of the path.

When all of the documents are received, the work package can continue along the path
to a final point— for example, loan approval.

For more information on defining work processes, see Chapter 7, “Working with Work
Processes” on page 51.

How Everything Fits Together

After you analyze the information that you want to process, determine the actions that
you want to perform, and decide how you want the information to flow through the work
management process, you are ready to create a work process diagram, which is the
graphical representation of your work process.

A work process diagram shows how work moves through the various activities in the
process, noting what tasks the activity involves. It describes the flow, the main
elements, and the key measuring points of a work process.

The work process diagram in Figure 1 shows how information might flow through a
mortgage loan company.

23 Mew VWork Process - LNAPPL
Work process  Selected Edit View Options
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CREDITRFT
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Figure 1. Sample Work Process Diagram

Each symbol in the work process diagram represents a point at which work is done,
documents are collected, or decisions are made. A mortgage loan application must be
reviewed, supporting documentation must be collected, and the application must be
approved or rejected, depending on certain criteria.
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Each symbol also has information associated with it, which can describe the work that
is done, the information that is collected, or the decisions that are made.

For information on using the work process editor to create a work process diagram, see
Chapter 8, “Using the Work Process Window” on page 56.

How Workfolder Application Facility Uses the Work Process
You can use Work Management Builder to create action lists, workbaskets, and work
processes. However, you must log on to Workfolder Application Facility and check in
any new or updated action lists, workbaskets, and work processes before Workfolder
Application Facility can use them. The new or updated data then becomes part of the
Workfolder Application Facility database.

When you check in an action list, workbasket, or work process, you permanently store
the new or updated data associated with it on Workfolder Application Facility. When you
check out an action list, workbasket, or work process, Work Management Builder
queries Workfolder Application Facility, stores a copy of the data on your workstation,
and prevents anyone else from updating it.

Although you can use Work Management Builder to build action lists, workbaskets, and
work processes, you cannot use Work Management Builder to run the work process.
You must run the work process you create with Work Management Builder on
Workfolder Application Facility.

Learning about Work Management Builder

This book provides a task-oriented approach to creating and working with action lists,
workbaskets, and work processes. In Work Management Builder windows, these action
lists, workbaskets, and work processes are called objects, and are represented by
icons.

Use Chapter 4, “Using Work Management Builder Objects” on page 26 to get an
overview of the actions that you can perform on Work Management Builder objects.
Then read Chapter 5, “Working with Action Lists” on page 36, through Chapter 7,
“Working with Work Processes” on page 51 for a detailed description of creating and
working with action lists, workbaskets, and work processes, including an explanation of
the choices that you can make on different windows. Chapter 8, “Using the Work
Process Window” on page 56 explains how to use the work process editor to create
your work process diagram.

Before you begin working with Work Management Builder, you can complete the Work
Management Builder tutorial if it is installed on your workstation. This online tool lets
you read about Work Management Builder functions and then try the steps necessary
to perform the functions.

For a complete description of the Work Management Builder tutorial, see Appendix A,
“Using the Work Management Builder Tutorial” on page 89 For instructions on installing
the tutorial if it is not already installed on your workstation, see Chapter 2, “Installing
Work Management Builder” on page 7.
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Context-sensitive online help is always available with Work Management Builder. The
type of help that is displayed is determined by what you select before you request help
or what task you are doing when you request help.
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Chapter 2. Installing Work Management Builder

This chapter explains how to install and configure Work Management Builder. You can
install only Work Management Builder or Work Management Builder and the Work
Management Builder tutorial on your workstation. You can use the installation utility to
either install or delete (uninstall) Work Management Builder.

The installation utility guides you step by step through the installation process. The
utility prompts for input, such as the names of the disk drives and directories where you
want Work Management Builder software installed. In addition, online help is always
available. To display context-sensitive help, press F1 or click on the Help push button
in a window.

Who Should Install Work Management Builder

To install Work Management Builder, you must understand the communications,
hardware, software, and storage prerequisites for Work Management Builder. You are
expected to be familiar with installing hardware and software on a workstation that is
used as part of a network with connections to an AS/400 host computer with Workfolder
Application Facility installed. You must also be familiar with Operating System/2 (0S/2)
installation, configuration, and terminology.

In addition, you are expected to be familiar with Workfolder Application Facility
requirements of your enterprise and your communications configuration.

Hardware and Software Requirements

You must have an IBM-compatible workstation capable of running OS/2 with the
following:

¢ 10MB available disk space (20MB available disk space is recommended for a large
database)

¢ 4MB random access memory (RAM) above existing OS/2 memory requirements
(additional RAM is recommended for increased performance)

e 1.44MB diskette drive (3.5-inch)

e Any IBM color or monochrome display supported that the workstation and OS/2
supports

¢ An OS/2-supported mouse
e Any OS/2-supported printer or plotter
¢ |BM Token-Ring Network 16/4 Adapter/A or higher
You must have OS/2 installed on your workstation. Personal Communications

(PCOMM) must be configured for APPC with 5250 Work Station Feature over IBM
Token-Ring Network . Also, PCOMM must be running before you begin the installation.
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In addition, you must be connected to an AS/400 host system operating Workfolder
Application Facility to run Work Management Builder.

Double-Byte Character Set Work Management Builder Users

If you have a double-byte character set version of Workfolder Application Facility
installed and plan to install Work Management Builder, follow these steps before
installation:

1. Select option 3, Administrative Processing, from the Workfolder Application Facility
main menu, EKDOOO.

2. Select option 5, Update Profiles, from menu EKD300.
3. Select option 5, Action Lists, from menu EKD330.
4. Select option 9, Change=9, next to the *MANAGE action list.
5. Press Enter.
6. Press the PageDown key.
7. Customize the prompt information for the following option line of the *MANAGE
action list profile:
Function
Screen Prompt Code Description
50 = User-defined option 0050 User-defined option

8. Press Enter. You receive the following Workfolder Application Facility message:
EKD7555 - Action 1ist profile changed successfully
9. Press F3=Exit.

Before You Begin Installing Work Management Builder

Before you begin installation, you must be familiar with the OS/2 communications
configuration of your workstation and your connection to an AS/400 host computer with
Workfolder Application Facility installed. For example, you need to know the partner
logical unit (PLU) alias used to reference the AS/400 host system. You also need to be
familiar with Personal Communications (PCOMM) and Advanced Program-to-Program
Communications (APPC) with 5250 emulation.

Use Table 1 on page 9 to help you gather the information you need before you begin
the installation process. You might need to contact your local area network (LAN)
administrator for PCOMM information and the AS/400 system administrator for
Operating System/400 (OS/400) information.
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Table 1. Installation Information

Information Needed Your Information

Directory where you want to install Work Management Builder—for
example, C:\EHLWAF

Directory where you want to install Work Management Builder database
files—for example, C\EHLWAF\WORK

Partner logical unit (PLU) alias (nickname) that is assigned to your
AS/400 system

Name of the program library that was specified when Workfolder
Application Facility was installed—for example, EKDLIB

Language-specific codepage that your AS/400 system is set to—for
example, 037

Installing the Basic Product and Tutorial

To install only the basic Work Management Builder feature or both Work Management
Builder and the Work Management Builder tutorial, do the following:

1. Make sure that PCOMM is running.

2. From the OS/2 desktop, switch to or start an OS/2 window or OS/2 full-screen
session.

3. Make sure that the OS/2 date and time values are correct.

4. Insert Work Management Builder Installation Diskette 1 in your workstation diskette
drive.

5. At the OS/2 prompt, type ANINSTALL and press Enter. You see the Work
Management Builder Installation window shown in Figure 2 on page 10. The
Welcome window is also displayed. The Welcome window contains information you
should read before you continue with the installation.
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l Continue 2 | Cancel I

Figure 2. Work Management Builder Installation Window

6. Read the information in the window and then click on the Continue push button.
You see the following messages: Loading files and Querying product
information .

You see the Install window, which displays information about Work Management
Builder.

7. Select one or both check boxes from the Options group. You can select the
following:

Update CONFIG.SYS
To automatically update your CONFIG.SYS file. If you select Update
CONFIG.SYS, the installation utility also creates a backup of your current
CONFIG.SYS file in your file directory and names it CONFIG.BAK. It is
recommended that you select the Update CONFIG.SYS check box.

If you leave this check box blank and continue, the installation utility does not
update your CONFIG.SYS file for you. Therefore, you must manually update
your CONFIG.SYS file before you start Work Management Builder. See
“Updating Your CONFIG.SYS File” on page 15 for the information you need to
add to your CONFIG.SYS file.

If you leave this check box blank, you are prompted to confirm that you want to
manually update your CONFIG.SYS file. Click on the Yes push button to
continue with the installation and manually update your CONFIG.SYS file before
you start Work Management Builder. Click on the No push button to return to the
Install window, where you select the Update CONFIG.SYS check box and
restart the installation.
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Overwrite files
To overwrite any file that has the same name as a Work Management Builder
file. If you select Overwrite files , any existing Work Management Builder files
that are found are automatically overwritten. This is useful if you start installing
Work Management Builder and stop before installation is completed. When you
start the installation process again, any files that are already copied do not need
to be recopied.

If you leave this check box blank, you are prompted to confirm each file before it
is overwritten.

8. Click on the OK push button to start the installation process. The Querying
product information message is displayed. You see the Install - directories
window shown in Figure 3.

W Install - directories

Select the components that you want to install:

E'Wurk Management Builder Feature
‘work Management Builder Tutorial

Bytes needed: 4,000,000

Enter the directories where you want to install the
components. These directories will be created if they do not
already exist.

File directory: CAEHLWAF
Data directorny: CAEHLWARWORK
!nstall...; |Disg space...g lCancelg | Help ]

Figure 3. Install - Directories Window

Use this window to install Work Management Builder. You can use this window to
check the available disk space for your workstation and to specify the directories
where you want to install Work Management Builder components. You can also
use this window to determine which drives have enough disk space to install the
components you select.

9. Select the name of the component that you want to install from the selection list.
You can select one or both of the following:

Work Management Builder feature
To install only the basic Work Management Builder feature
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Work Management Builder tutorial
To install the Work Management Builder tutorial. You must install Work
Management Builder to install the Work Management Builder tutorial. If you
select only the Work Management Builder tutorial, you are prompted to install
Work Management Builder.

To select both components, click on the Select all push button.

To display a description of either component, select the component name, then
click on the Descriptions push button.

To determine the number of bytes either component needs to be installed on your
workstation, select the component. The bytes needed are displayed in the Bytes
needed field.

To check the available disk space on your workstation and ensure that you have
enough space to install Work Management Builder, select the component and then
click on the Disk space push button. You see the Disk space window shown in
Figure 4.

W Disk space

Bytes available on drive:

C: 2,776,064 7 Bytes needed:
D 8,307,712 - 4,000,000
0 11497472 _

R 155,479,040  Installation:
S: 119,443,456 .  possible

| 0K ; |Cancela |HE:||];

Figure 4. Disk Space Window

This window displays the number of bytes needed to install Work Management
Builder, as well as the number of bytes available on each drive.

Select a drive from the Bytes available on drive list box. As you select a drive
from the list, one of the following is displayed to the right of the list box:

Installation: possible
Indicates that the disk space available on the selected drive is adequate for
installation

Installation: not possible
Indicates that the disk space available on the selected drive is not adequate for
installation.

Click on the Change directories to selected drive  check box to change the file
and data directories on the Install - directories window to the selected drive.

10. In the File directory field, specify the drive, path, and directory where you want to
install Work Management Builder files. The default is C:\EHLWAF. If you specify a
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directory other than the default directory, you must specify a fully qualified path.
The installation utility creates the directory if you specify a directory that does not
already exist.

11. In the Data directory field, specify the drive, path, and directory where you want to
store Work Management Builder data files. The default is CAEHLWAF\WORK. If
you specify a directory other than the default directory, you must specify a fully
qualified path. The installation utility creates the directory if you specify a directory
that does not exist.

You can specify a shared (LAN) drive location for Work Management Builder data
files. However, you cannot subsequently run more than one Work Management
Builder session at the same time using the shared data files.

12. Click on the Install push button to transfer the product files. You see the Install -
progress window shown in Figure 5.

W Install - progress

Work Management Builder
Component. Work Management Builder Tutorial

-Progress
Status: Unpacking Elapsed Time: 00:02:32
o Files 81
-Files
Source: lehltut.ex{@
Target: clehbwafiehltut.exe

Swop | | Help |

Figure 5. Install - Progress Window

You can use this window to check the progress of the installation. The Progress
group displays the number of files to be transferred, the status of the installation,
and the amount of time that has elapsed. The slider indicates how many of the files
have been transferred. The Source and Target fields display the name of the file
being transferred.

To stop the file transfer, click on the Stop push button. Note that if you click on the
Stop push button, file transfer might not be complete and you cannot use the
product.

During file transfer, you see the PCOMM settings window shown in Figure 6 on
page 14.
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W/ Communication settings

-Current Communications Manager settings .

Partner logical unit name USIBMWL.ASA00DS1

Partner logical unit alias AS400DS1 |z;

-Current 05/400 settings

Code page (037 US English B

workfolder Application

Facility program library ‘EKDLIB

I Save “Canceli ‘ Help i

Figure 6. Communication Settings Window

13.

14.

15.

16.

17.
18.

19.

In the Partner logical unit alias  drop-down list, select the alias (nickname) that is
assigned to your AS/400 system. Do not continue with the installation if you are
uncertain about the information that is required in this field. All of the aliases that
are defined for your workstation are displayed. If the alias for your AS/400 system
is not displayed, do not continue with the installation. You must configure PCOMM
for 5250 emulation before you can install Work Management Builder.

When you select an alias, the Partner logical unit name field changes
automatically to reflect the associated AS/400 LAN name. In some cases, the alias
and name might be the same.

In the Code page drop-down list, select the language-specific code page that is
installed on your AS/400 system. Both the code page number and the language
are listed. The default code page is 037 US English. Do not continue with the
installation if you are unsure about the information required in this field. You might
need to contact your AS/400 system administrator for the OS/400 information.

In the Workfolder Application Facility program library field, specify the name of
the program library that was specified when Workfolder Application Facility was
installed. The default name is EKDLIB. If the library name is different on the
AS/400 system, replace the default name with your specific name. Do not continue
with the installation if you are uncertain about the information that is required in this
field. You might need to contact your AS/400 system administrator for 0S/400
information.

Click on the Save push button. When the files on diskette 1 have been transferred,
you are prompted to insert Work Management Builder Installation Diskette 2.

Insert diskette 2.

Click on the Continue push button to continue the installation. A message box is
displayed confirming that the installation is complete.

Select Exit from the File pull-down or click on the Exit push button to exit the
installation utility. If you chose to make the changes to your CONFIG.SYS file, you
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must make those changes before continuing to the next step. See “Updating Your
CONFIG.SYS File” on page 15 for the information you need to add to your
CONFIG.SYS file.

20. Shut down and restart your workstation for the changes to your CONFIG.SYS file
to take effect.

After you restart the workstation, you can start Work Management Builder. The Work
Management Builder Folder icon is displayed on the OS/2 desktop.

Updating Your CONFIG.SYS File

If you choose not to have the installation utility automatically update your CONFIG.SYS
file, you must manually update your CONFIG.SYS file. This section provides the
statements you need to add to your CONFIG.SYS file before you can use Work
Management Builder.

When you make changes to the statements in your CONFIG.SYS file, you must make
sure that there is a semicolon (;) at the end of each line that you change. Also,
C:\EHLWAF is the default directory used during the installation. If you want to install
Work Management Builder in a different directory or drive, use that directory instead of
C:\EHLWAF.

To manually update the statements in your CONFIG.SYS file, follow these steps:

1. Type COPY C:\CONFIG.SYS C:\CONFIG.BAK at the OS/2 prompt to make a copy
of your CONFIG.SYS file.

2. Use any text editor to edit your CONFIG.SYS file:

a. Add C:\EHLWAF; to the SET LIBPATH= statement.
b. Add C:\EHLWAF; to the SET PATH= statement.
c. Add C\EHLWAF; to the SET HELP= statement.

3. Save and close the CONFIG.SYS file.
4. Shut down and restart your workstation for the changes to your CONFIG.SYS file
to take effect.

After you restart the workstation, you can start Work Management Builder. The Work
Management Builder Folder icon is displayed on the OS/2 desktop.

Selecting the Work Management Builder Folder

Double-click on the Work Management Builder folder icon on the OS/2 desktop to
display the IBM Work Management window shown in Figure 7 on page 16.
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Figure 7. IBM Work Management Window

The IBM Work Management window contains the Work Management Builder icon and
the Work Management Builder Tutorial icon, if it is installed.

To start Work Management Builder, double-click on the Work Management Builder icon
in the Work Management Builder folder window. The Work Management Builder
copyright window is displayed. You are now ready to use Work Management Builder.
See Chapter 3, “Getting Started” on page 19, for more information on using Work
Management Builder.

To start the tutorial, double-click on the Work Management Builder Tutorial icon in the
Work Management Builder Folder window. You are now ready to use the tutorial. See
Appendix A, “Using the Work Management Builder Tutorial” on page 89 for a
description of tutorial features.

Deleting Work Management Builder

You can delete Work Management Builder from your workstation. Before you delete the
files, make sure that Work Management Builder is not already running on your
workstation.

When you delete Work Management Builder from your workstation, you delete only the
files that were transferred during installation. The data files that you create when you
use Work Management Builder are not deleted.

Follow these steps to delete Work Management Builder.

1. From the OS/2 desktop, switch to or start an OS/2 window or OS/2 full-screen
session.

2. Insert Work Management Builder Installation Diskette 1 in your workstation diskette
drive.

3. At the OS/2 prompt, type ANINSTALL and press Enter. You see the Work
Management Builder Installation window shown in Figure 2 on page 10.

4. Read the information in the window, and then click on the Continue push button.
You see the Installation options window shown in Figure 8 on page 17.
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W Installation options

Components of the product have already been
installed. Select an option from the list below that
indicates how you would like to proceed.

77 Update the currently installed components
% Delete the installed components and re-install
%7 Install additional components

Ignntinue; | Cancel i

Figure 8. Installation Options Window

5. Select the Delete the installed components and re-install radio button to delete
Work Management Builder from your workstation. You can then reinstall Work
Management Builder.

The following radio buttons are also displayed:

Update the currently installed components
To update Work Management Builder as modifications or new releases become
available.

Install additional components
To install the Work Management Builder tutorial if you installed only Work
Management Builder. This selection is not displayed if both the basic Work
Management Builder product and the tutorial are installed on your workstation.

You see the following messages: Loading files and Querying product
information and then you see the Delete window,which information about Work
Management Builder.

6. Select the name of the component that you want to delete from the selection list.
You can select one or both of the following:

Work Management Builder feature
To delete Work Management Builder. You must delete the tutorial if you delete
the basic feature.

Work Management Builder tutorial
To delete the Work Management Builder tutorial.

To select both components, click on the Select all push button.

7. Click on the Delete push button to delete the selected component, or click on the
Cancel push button to cancel the deletion.

After you click on the Delete push button, you see the Delete - progress window
shown in Figure 9 on page 18.
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work Management Builder
Component: Work Management Builder Feature

~Progress
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0 Files
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Figure 9. Delete - Progress Window

The status in the Progress group changes to Deleting files , indicating that Work
Management Builder is being deleted. The Work Management Builder package file

is processed, and all its files are deleted.

To stop the file deletion, click on the Stop push button. You are prompted to
confirm that you want to stop the process. Click on the Yes push button to stop
the delete process. Note that, if you click on the Yes push button, file deletion is
not complete and you cannot use the product. Click on the No push button to

continue the delete process.

When you have finished deleting the files, a message is displayed confirming that

the deletion was successful.

8. Click on the OK push button. You see the Install window, which provides

information about Work Management Builder.

You can reinstall Work Management Builder or you can exit the installation utility.

To exit the installation utility without reinstalling Work Management Builder, select Exit
from the File pull-down or click on the Exit push button.
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Chapter 3. Getting Started

If you have not installed Work Management Builder, refer to Chapter 2, “Installing Work
Management Builder” on page 7, for complete installation instructions.

Working with Work Management Builder Windows

You can use Work Management Builder windows to work with workbaskets, action lists,
and work processes. The primary window is the Work Management Builder window,
which contains objects (icons) that represent groups of action lists, workbaskets, and
work processes. See Figure 10.

You can use the Work Management Builder window to display the windows associated
with these objects. These windows are called object container windows because they
contain the action list, the workbasket, and the work process objects.

3 matches; 3 total

Warkbaskets  Action Lists  Work Processes

Figure 10. Work Management Builder Window

The title bar of the window displays the window name. The menu bar, which is located
below the title bar, contains keywords that let you work with the objects in the window.
When you select a keyword, a pull-down menu is displayed. Many of the pull-down
actions work on one or more selected objects.

You can use the pull-down selections to open an object container window, change the
display of the Work Management Builder window, log on and off Workfolder Application
Facility, and get online help. For a detailed explanation of each pull-down choice, select
the choice and press F1.

The status area is located below the menu bar. The status area shows the number of
objects currently contained in the window and the total number of objects available. To
remove the status area, select Status area from the View pull-down. To display the
status area, select Status area again. For more information on filtering the list of
objects to include only certain objects, see “Filtering the View” on page 33.

Work Management Builder provides visual cues when an object is new, in use, or
checked out.
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When an object is new, its icon contains a diamond in its lower right corner to
indicate its status.

When a window for an object is open (that object is in use), its icon contains a
cross-hatched pattern.

risiny When an object is checked out, its icon contains a check mark in its lower right
ol corner.

Using Object Container Windows
From the Work Management Builder window, you can choose to work with action lists,
workbaskets, or work processes in an object container window. An object container
window contains object icons that represent action lists, workbaskets, or work
processes. These icons are sorted alphabetically from left to right, top to bottom.

To open one of these object container windows, double-click on the icon associated
with the object you want to work with. You can also select the icon and then select
Open from the Selected pull-down. Figure 11 is an example of a Workbaskets
container window.

12 workbaskets
Selected Edit View Help

9 matches; 9 total

APPRYLTR EXCEPT EXCEPTI: FINALRYW  INIT

PROCAPP PROCCHDET REJECTLTR WwORKBACK2

Figure 11. Workbaskets Container Window

You can use the pull-down selections to open an object window, work with existing
objects, change the objects that are displayed in the object container window and how
the window is displayed, and get online help. For a detailed explanation of each
pull-down choice, select the choice and press F1.

All actions available from an object container window menu bar are discussed in detail
in Chapter 4, “Using Work Management Builder Objects” on page 26.
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Using Object Windows
When you double-click on an icon in an object container window, the object window
associated with the icon is displayed.

Double-click on an icon in the Action Lists container window to display the Action
List window, where you can define or update an action list. For more information
on working with the Action List window, see Chapter 5, “Working with Action Lists”
on page 36.

Double-click on an icon in the Workbaskets container window to display the
Workbasket window, where you can define or update a workbasket. For more
information on working with the Workbasket window, see Chapter 6, “Working with
Workbaskets” on page 42.

Double-click on an icon in the Work Processes container window to display the
Work Process window, where you can use the work process editor to define or
update a work process. For more information on working with the Work Process
window, see Chapter 8, “Using the Work Process Window” on page 56.

You can also select the icon and then select Open from the Selected pull-down.

Opening Work Management Builder

Follow these steps to open Work Management Builder:

1. Double-click on the Work Management Builder Folder icon on the OS/2 desktop.

You see the IBM Work Management window shown in Figure 12.

v
i

whork Management Builder Tutarial “work Management Builder

Figure 12. IBM Work Management Window

The IBM Work Management window contains the Work Management Builder icon
and the Work Management Builder Tutorial icon, if it is installed.

Double-click on the Work Management Builder icon. You see the About window,

which provides information about Work Management Builder. To continue with
Work Management Builder, click on the OK push button or press Enter. The About
window closes. If you have not logged on to Workfolder Application Facility, a
message reminds you that you must log on at least once. Click on the OK push
button or press Enter. You see the Work Management Builder Logon window
shown in Figure 13 on page 23.
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Logging On to Workfolder Application Facility

You can use Work Management Builder with a connection to Workfolder Application
Facility or locally without a connection. When you use Work Management Builder
without a host connection, you are in local mode.

You must log on to Workfolder Application Facility at least once before you work in
local mode. In addition, Work Management Builder uses Workfolder Application Facility
as its main database, so a connection to Workfolder Application Facility is necessary to
be sure that you are working with data that is current as of the time you log on.

Work Management Builder uses commitment control when checking objects in and out
of Workfolder Application Facility. The first time a user logs onto Workfolder Application
Facility, journaling is activated through Work Management Builder. Successful logon is
achieved when a user is able to begin journaling for the work management objects or
journaling was previously started.

You can use one of the following ways to ensure successful logon to the host from
Work Management Builder.

1. When Workfolder Application Facility files are journaled as part of the application’s
disaster recovery plan, it is not necessary to start journaling when logging onto the
host through Work Management Builder.

2. Work Management Builder starts journaling during a logon process if journaling has
not previously started. When users are logged onto Workfolder Application Facility
and have any necessary work management files opened, a logon is unsuccessful.

3. You can issue the following command to start journaling Work Management Builder
files. Before doing so, however, be sure no users are logged on to the system or
working on any work management functions.

e From an AS/400 command line type EKDJRNSTRB ASP(01) ASP=. Enter the
auxiliary storage pool where journaling executes. The default ASP is the
system ASP(01).

If the command fails, an error is written to the EKDOO08O0 error file. Check this file
to be sure there are no error messages for this command before attempting your
first logon to Work Management Builder.

Once all objects are checked in and the user has confirmed that it is not necessary to
logon to Work Management Builder, you can stop journaling by entering EKDJRNSTPB at
an AS/400 command line.

Logging off Work Management Builder does not stop journaling of work management
files.

Using Work Management Builder with a Host System Connection

You must be connected to Workfolder Application Facility to check out objects you want
to update and to check in objects you created or updated.
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When you check out an object, Work Management Builder queries Workfolder
Application Facility for the object you want to update and stores a copy of the data on
your workstation. When you check in an object, you permanently store the new or
updated data associated with the action list, workbasket, or work process on Workfolder
Application Facility.

For more information on checking objects in and out of Workfolder Application Facility,
see “Checking Out Objects” on page 28 and “Checking In Objects” on page 28.

Before you establish a connection to Workfolder Application Facility, make sure that
IBM Personal Communications (PCOMM) is configured and running on your
workstation. Follow these steps to log on to Workfolder Application Facility.

1. Type your Workfolder Application Facility user ID in the User ID entry field in the
Work Management Builder Logon window, shown in Figure 13.

% Work Management Builder Logon

é%._._izzg e | Local ” Help I

Figure 13. Work Management Builder Logon Window

2. Type your Workfolder Application Facility password in the Password entry field.
Your password displays as asterisks (*) for security reasons.

3. Click on the Log on push button to log on to Workfolder Application Facility. Note
that the Log on push button is not available until you type your user ID or
password.

To cancel the logon and work in local mode, click on the Local push button. To
cancel the logon and close Work Management Builder at program startup, select
Close from the title bar menu. The title bar icon is located in the upper left corner
of the Work Management Builder Logon window.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

If you are in local mode, you can establish a connection to Workfolder Application
Facility from the Work Management Builder window by selecting Log on from the
Services pull-down. You see the Work Management Builder Logon window shown in
Figure 13.

After you have logged on to Workfolder Application Facility, you see the Loading Data
window shown in Figure 14 on page 24.
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Figure 14. Loading Data Window

The progress indicator shows the percentage of the host system data that has been
loaded. Click on the Help push button to display context-sensitive help.

Using Work Management Builder without a Host System Connection

You can use Work Management Builder in local mode—without a host connection—to
perform the following tasks:

e Create and update objects. Work Management Builder saves the objects locally.

e Browse Work Management Builder objects that you saved locally or checked out
during a previous session.

e Print information associated with an object.

e Copy information associated with an object.

However, it is recommended that you use Work Management Builder with a connection
to Workfolder Application Facility. This ensures that your data is current as of the time
you log on. In addition, if a number of users are involved in defining a work process,
they can share and view common workbaskets, action lists, and work processes on
Workfolder Application Facility.

To use Work Management Builder in local mode, click on the Local push button in the
Work Management Builder Logon window shown in Figure 13 on page 23. You do not
need to type a user ID or password. If you click on the Local push button, Work
Management Builder retrieves data locally. You must log on to Workfolder Application
Facility at least once before you work in local mode.
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Atfter you click on the Local push button, you see the Loading Data window shown in
Figure 14. The progress indicator shows the percentage of the data that has been
loaded. Click on the Help push button to display context-sensitive help.

Working in Different Edit Modes

Work Management Builder edit modes lets you create and update new objects, update
existing objects if they are checked out, and browse existing objects (including those
that are checked out by another user) without checking them out. You can use the
following edit modes:

Create mode
To create and define new objects. Create mode is always active when an object is
new. An object is considered new before it is checked in for the first time.

Update mode
To update the contents of workbaskets, action lists, and work processes if they
already exist and are checked out.

Browse mode
To view existing objects without checking them out. You cannot update the contents
of objects while in browse mode.

Logging Off Workfolder Application Facility
To log off Workfolder Application Facility and work in local mode:
1. Select Log off from the Services pull-down. A confirmation window is displayed.
2. Click on the Yes push button to log off Workfolder Application Facility, or click on
the No push button to keep your connection to Workfolder Application Facility.

If you click on the Yes push button, Work Management Builder operates in local mode.
It also operates in local mode whenever you cannot log on to Workfolder Application
Facility because the connection is temporarily unavailable.

In addition, Work Management Builder protects your data by operating in local mode if
the connection between your workstation and Workfolder Application Facility is broken
during a session.

Closing Work Management Builder

To close Work Management Builder, select Close from the title bar pull-down in the
Work Management Builder window. The title bar icon is located in the upper left corner
of the Work Management Builder window. All open Work Management Builder windows
are closed, and you are logged off Workfolder Application Facility (if you are logged
on). You are prompted to save any data that you have not yet saved.
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Chapter 4. Using Work Management Builder Objects

From the Work Management Builder window shown in Figure 15, you can choose to
work with groups of workbasket, action list, or work process objects by opening one or
more object container windows associated with these object types.

+¥4

(5 Work Management Builder
Selected V¥Yiew Services Help

3 matches: 3 total

4

Workbaskets Action Lists  Work Processes

Figure 15. Work Management Builder Window

The Work Management Builder window is displayed after you log on to Workfolder
Application Facility or click on the Local push button in the Logon window. For more
information on logging on to Workfolder Application Facility or working in local mode,
see “Logging On to Workfolder Application Facility” on page 22.

Opening an Object Container Window

From an object container window, you can open, check out, update, and check in
existing objects, and you can create new objects.

To open an object container window, double-click on the icon in the Work Management
Builder window associated with the object you want to work with. You can also select
one or more icons and then select Open from the Selected pull-down.

For example, to open the Workbaskets container window shown in Figure 16 on

page 27, double-click on the Workbaskets icon in the Work Management Builder
window.
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Figure 16. Workbaskets Container Window

Closing an Object Container Window

To close an object container window, select Close from the title bar pull-down in the
object container window. The title bar icon is located in the upper left corner of the
object container window.

You are prompted to save any data that you have not yet saved. All open object
windows are closed as well as the object container window.

Creating an Object

To create a new object, select Create another from the Edit pull-down. The window
that is displayed lets you define that object.

For more information on creating an action list, workbasket, and work process, see
“Creating an Action List” on page 37, “Creating a Workbasket” on page 42, and
“Creating a Work Process” on page 52, respectively.

Opening an Object

You can open one or more objects at a time. If you have checked out the object you
open, it is displayed in update mode. If you have not checked out the object, it is
displayed in browse mode. If you open a new object, it is displayed in create mode. For
more information on Work Management Builder edit modes, see “Working in Different
Edit Modes” on page 25.

Opening One Object
To open a single object from an object container window, double-click on the object
icon. You can also:

1. Select the icon representing the object you want to open.
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2. Select Open from the Selected pull-down.

The object is opened and the window for the opened object is displayed.

Opening More than One Object
To open more than one object at a time:

1. Select the icons or text representing the objects you want to open.

2. Select Open from the Selected pull-down. All selected objects are opened and the
windows for the selected objects are displayed.

Checking Out Objects

Before you can update an object, you have to check it out so that other users cannot
make changes to it at the same time. When you check out an object, Work
Management Builder gets the most current copy of the data about the object from
Workfolder Application Facility, which puts a lock on the data so that other users cannot
change it.

You can check out an opened object from an object window or an unopened object
from an object container window. When you check out an object, a check mark is
displayed below its icon.

Note that you must be logged on to Workfolder Application Facility before you can
check out an object. For more information on logging on, see “Logging On to
Workfolder Application Facility” on page 22.

Checking Out an Object from a Container Window
Follow these steps, to check out one or more objects from the Workbaskets, the Action
Lists, or the Work Processes container window.

1. Select the icon representing the object you want to check out.

2. Select Check out from the Selected pull-down. A check mark is placed below the
icon to indicate that you checked out the object.

Checking Out an Object from an Object Window
If you decide to update an object that you opened in browse mode, you can check it
out if you are logged on to Workfolder Application Facility.

To check out an object from the Action List or the Workbasket window, click on the
Check out push button. To check out an object from the Work Process window, select
Check out from the Work process pull-down.

Checking In Objects

Objects that you create are not part of the Workfolder Application Facility database until
they are checked in. Also, any changes that you make to existing objects are not
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reflected in the Workfolder Application Facility database until you check the updated
objects in.

You must verify a new or updated work process before you check it in. For more
information on verifying a work process diagram, see “Verifying a Work Process” on
page 77.

Note that you must be logged on to Workfolder Application Facility before you can
check in an object. For more information on logging on, see “Logging On to Workfolder
Application Facility” on page 22.

Checking In an Object from a Container Window
To check in one or more objects from the Workbaskets, the Action Lists, or the Work
Processes container window:

1. Select the icon representing the object you want to check in.

2. Select Check in from the Selected pull-down. The diamond or check mark is
removed from the icon to indicate that you checked in the object. Work
Management Builder also stores a copy of the object locally so that you can
browse it. For more information on Work Management Builder editing modes, see
“Working in Different Edit Modes” on page 25.

Checking In an Object from an Object Window
To check in an object from the Action List or the Workbasket object window, click on
the Check in push button. To check in an object from the Work Process window, select
Check in from the Work process pull-down.

Resolving Name Conflicts
If you try to check in a new object with a name that currently exists on Workfolder
Application Facility, a message box is displayed prompting you to rename the new
object. When a conflict occurs, you must rename the new object before you check it in.
Click on the OK push button. You see the Rename window shown in Figure 17.

W Rename Action List

Old name EXCEPT15
Description Exception Action List
Mew name

e Cancel I ] Help I

Figure 17. Rename Window

The name and description of the existing object are displayed in the Old name and
Description display fields, respectively.
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To rename an object:

1. Type the new name for the object in the New name entry field. You can type up
to 10 characters, including digits and special symbols.

2. Click on one of the following push buttons:

Rename  To rename the object, close the Rename window, and continue the
check-in process.

Cancel To close the Rename window and cancel the check-in process.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Copying an Object

You can create a copy of a selected object. The copy contains the same data as the
selected object, but with a unique name generated by Work Management Builder. To
make a copy of an existing object:

1. Select the icon representing one or more objects that you want to copy.

2. Select Copy from the Edit pull-down.
The new object is displayed in the object container window near the original object.
Before you work with the new object, you might want to change its name to something
more meaningful than the name generated by Work Management Builder. You cannot
change an object name after you check it in to Workfolder Application Facility.
To rename a new action list or workbasket object:

1. Select the icon representing the object you want to rename.

2. Select Open from the Selected pull-down. The object window is displayed.
3. Type over the name in the Name entry field in the object window.
4

. Click on the Save push button.

To rename a new work process object:
1. Select the icon representing the object you want to rename.
2. Select Open from the Selected pull-down. The object window is displayed.

3. Select Work process details from the Work process pull-down. The Work
Process Details window is displayed.

4. Type the new name in the Name entry field and the new description in the
Description entry field.

5. Click on the OK push button.

6. Select Save work process from the Work process pull-down.

More information on using the Work Process Details window can be found on page
“Naming a Work Process” on page 76.

30  Workfolder Application Facility V4.1: User's Guide for the Work Management Builder



Deleting an Object

You can delete one or more objects that are new or that you checked out. You must
be logged on to Workfolder Application Facility to delete an object that is checked out.
To delete one or more objects:

1. Select the icons representing the objects you want to delete.

2. Select Delete from the Edit pull-down. A confirmation message is displayed for
each object.

3. Click on OK to confirm each deletion.

Any object that you delete from Work Management Builder is not deleted from
Workfolder Application Facility until the Delete profiles function has been run. This
Workfolder Application Facility function deletes only those objects that are eligible for
deletion. For example, an action list is not eligible for deletion if it is associated with any
workbasket in the system.

If you reuse the name of a deleted object, you cannot check the new object in until the
deleted object has been successfully deleted from Workfolder Application Facility.

Printing the Contents of an Object

You can print the information associated with one or more selected objects to the OS/2
default printer. The information that is printed includes the name and the description of
the object, the date and time of creation and the last update, whether the object is
checked out, and the user ID of the person who checked the object out.

If you print a work process that has been verified, Work Management Builder also prints
the text translation of certain nodes and connectors. You can also print a work process
diagram. For information on printing the graphical representation of the diagram itself,
see “Printing a Work Process Diagram” on page 80.

For information on changing the default printer, see your OS/2 documentation.

To print the information associated with a workbasket, action list, or work process:
1. Select the icon representing the object you want to print.

2. Select Print from the Selected pull-down in the object container window. You see
the Print window shown in Figure 18 on page 32.
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Figure 18. Print Window
3. Select the number of copies you want to print by using the Number of copies spin
button. You can print from 1 to 99 copies.
4. Click on one of the following push buttons:

Print To print the specified number of copies of the selected object on the
default printer.

Cancel To close the Print window without printing the selected object.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Releasing an Object

When you check out an object, Work Management Builder queries Workfolder
Application Facility for the data you want to update, stores a copy of the data on your
workstation, and locks the object so that other users cannot change it.

When you release an object, you remove the lock on the object. You might want to
release an object if you decide not to update an object that you checked out. After
release, the object is restored to the way it was before you checked it out, even if you
changed it.

An object that can be released has a check mark in the lower right corner of the icon,
indicating that it is checked out.
To release the lock on one or more objects:

1. Select the icon representing the object you want to release.

2. Select Release from the Selected pull-down. A confirmation message is displayed
for each object that you updated.

3. Click on OK to confirm each release.
Note that you must be logged on to Workfolder Application Facility before you can

release an object. For more information on logging on, see “Logging On to Workfolder
Application Facility” on page 22.
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Filtering the View

You can specify which group of objects to include in the object container window by
associating the object name with the object status criteria. Work Management Builder
then includes only those objects that meet the criteria in the current display. You can
work with any object in the object container window, regardless of whether or not it is
included in the current display.

Follow these stpes to filter the display to include certain objects.

1. Select Include from the View pull-down. You see the Include window shown in
Figure 19.

% Include
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Figure 19. Include Window

2. Type a name in the Name entry field. You can use an asterisk as a wildcard by
itself to represent all object names, or at the beginning or end of a name to
represent one or more missing characters. For example, type ab* to indicate object
names that begin with the characters ab.

3. Select one of the following from the Status group box:

All  To display a list of all objects with the name specified in the Name entry
field.

Modified
To display a list of all checked-out objects that were updated and that match
the name specified in the Name entry field, and all new objects that match
the name specified in the Name entry field.

Checked out only
To display a list of all checked-out objects that match the name specified in
the Name entry field.

New only
To display a list of all new objects that match the name specified in the
Name entry field.

Checked out and new
To display a list of all checked-out objects and new objects that match the
name specified in the Name entry field.
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4. Click on the OK push button to refresh the object container window to display
objects that match the include criteria.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

You can change the criteria in the Include window to redisplay hidden objects. To
display all of the object names in the object container window, type an asterisk (*) in
the Name entry field, select All from the Status group box, and click on the OK push
button.

Displaying a List of Checked-Out Objects
You can determine which objects are checked out by filtering the list of objects to
include only those that you checked out. To display a list of checked-out objects in the
Workbaskets, the Action Lists, or the Work Processes container window:

1. Select Include from the View pull-down. You see the Include window shown in
Figure 19 on page 33.

2. Type an asterisk (*) in the Name entry field.
3. Select Checked out only from the Status group box.
4. Click on the OK push button. The object list is refreshed to include only those

objects that you checked out.

Figure 20 shows a window view that is changed based on the include criteria.
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Figure 20. Action Lists Window Displaying Only Checked-Out Action Lists
This Action Lists window displays only action lists that you have checked out. Note that

the status area is changed to reflect the number of action lists that match the include
criteria out of the total number of action lists.
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Displaying a List of Updated Obijects
You can check in all of the objects you updated by filtering the list of objects to include
only those that you updated, and then checking in those objects.

To display a list of updated objects in the Workbaskets, the Action Lists, or the Work
Processes container window:

1. Select Include from the View pull-down. You see the Include window shown in
Figure 19 on page 33.

2. Type an asterisk (*) in the Name entry field.
3. Select Modified from the Status group box.
4. Click on the OK push button. The object list is refreshed to include only those
objects that you updated.
To check in the updated objects:
1. Select Select all from the Edit pull-down.
2. Select Check in from the Selected pull-down.

The updated objects are checked in to Workfolder Application Facility.
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Working with Action Lists

An action list, which is composed of functions and options, describes the actions that a
user can perform on a work package. When you create an action list, you can define
different actions that are performed on the entire work package (with function keys) or
on individual documents in the work package (with options).

The *MANAGE action list is shipped with the product. You can change but not delete it,
and you can associate it with any workbasket. It is always associated with the Search
for Work Packages interface.

An action list includes only those functions and options that you want the user to be
authorized to perform when the work process is run on Workfolder Application Facility.
For example, you might define an action list with only view and print functions. You can
then assign this action list to a workbasket at which a user only reviews work, but has
no need to change the work.

For more information on the function keys and options available, see Appendix B,
“Defining Function Keys and Options” on page 97.

An action list can describe:

¢ Function keys already defined on Workfolder Application Facility
¢ Function keys that you define in the Action List window
¢ Options that a user can select

In Work Management Builder, each action list is an object that is represented by an
action list icon. These action list objects are defined and displayed in the Action Lists
container window. A sample Action Lists container window is shown in Figure 21.
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Figure 21. Action Lists Container Window

From the Action Lists container window, you can open, check out, release, and check
in existing action lists, and create new action lists.
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Creating an Action List
To create a new action list:

1. Double-click on the Action Lists icon in the Work Management Builder window. You
can also select the Action Lists icon, then select Open from the Selected
pull-down. You see the Action Lists container window shown in Figure 21 on
page 36.

2. Select Create another from the Edit pull-down. You see the Action List window
shown in Figure 22.
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Figure 22. Action List Window

You can use this window to build an action list by adding functions and options to,
and deleting functions and options from, the function list below the Add and Delete
push buttons.

3. Type the name for the new action list in the Name entry field. You can type up to
10 characters, including digits and special symbols. The name must be unique for
an action list. The name is displayed in uppercase letters when you save the action
list or check it in. This is a required field.

4. Type a description for the action list in the Description entry field. You can type up
to 30 characters, including digits and special symbols. This is a required field.

5. Select an action list Type. You can select one of the following radio buttons:

Index To create an action list that defines only function keys. If you select
the Index radio button, the group box below is labeled Function list
and the Function description  drop-down list contains functions from
Workfolder Application Facility. For more information on the function
keys available for an index action list, see Table 3 on page 97.
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Work To create an action list that defines both function keys and options. If
you select the Work radio button, the group box below is labeled
Function and option list , and the Function and option description
drop-down list contains functions and options.

For more information on the function keys and options available for a
work action list, see Table 4 on page 98.

The default value for new action lists is Work .

Any function list that is already defined is deleted if you change the type. A warning
message is displayed if you select a different action list type.

This choice is not available when you open an action list in update mode. For
more information on Work Management Builder editing modes, see “Working in
Different Edit Modes” on page 25. If you want to change the action list type, you
can copy the action list, then change the type of the new action list. For more
information on copying an action list, see “Copying an Object” on page 30.

6. Select the description of the function or option that you want to include in the
function list from the Function description or Function and option description
drop-down list (for example, Add form to folder from the Function description
drop-down list).

This drop-down list contains a description of all possible functions and options,
regardless of what is currently in the function list. The functions (or options) that
are listed depend on whether you select Index or Work as the action list type.

The Number and Screen prompt fields are updated to display the default values
for the selected function or option.

The default function for a new action list is the first function or option in the
drop-down list. Any index action list that you define must contain an exit or a
cancel function. Any work action list that you define must contain an exit, a cancel,
a continue, or a force continue function.

7. Use the Number spin button if you want to change the function number or the
option (for example, F18 to replace F17). This drop-down list contains all possible
functions (and options), regardless of what is currently in the function list. The
choices available with this spin button depend on what you have selected from the
Function and option description  drop-down list.

8. Type a short description of the function or option in the Screen prompt entry field
if you want to change the screen prompt (for example, Add credit report ). This
description is displayed on the Workfolder Application Facility host system screen.
You can type up to 20 characters, including digits and special symbols. This is a
required field.

9. Click on the Add push button to add the function or the option to the function list. If
you try to add a function or an option with a number that is already defined, you
are prompted to confirm that you want to replace the existing function or option.
You use the Add push button to build your action list by adding functions and
options.
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10. Click on the Delete push button to delete the selected function or option from the
function list. When you select a function or an option, its description, number, and
screen prompt are displayed in the corresponding fields. You use the Delete push
button to change your action list by deleting functions and options.

11. Click on one of the following push buttons:

Save To save the information for this action list and close the window
without checking in the action list. The information is saved locally on
your workstation. Work Management Builder verifies the information in
the window for valid values before saving the action list.

Check in  To save the information for this action list, check in the action list, and
close the window. Work Management Builder verifies the information in
the window for valid values before checking in the action list. This
push button is available only if you are logged on to Workfolder
Application Facility.

Check out To check out the action list if you are working in browse mode without
closing the window. The data is refreshed with the most recent data
from Workfolder Application Facility. The Action List window switches
from browse mode to update mode, and you can make changes to the
action list. This push button is available only if you are logged on to
Workfolder Application Facility.

Cancel To cancel the Action List window without saving changes to the action
list. An unnamed icon is displayed in the Action Lists window. This
icon represents the action list that you cancelled. When you close the
Action Lists container window, the icon is removed.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Renaming an Action List

When you create a new action list, you must give it a uniqgue name. If an action list with
the same name already exists on your workstation, you are prompted to change the
name of the new action list when you click on the Save or the Check in push button in
the Action List window.

If an action list with the same name already exists on Workfolder Application Facility,
you are prompted to change the name of the new action list when you click on the
Check in push button in the Action List window, or select Check in from the Selected
pull-down in the Action Lists container window. For more information on changing the
name of an action list, see “Resolving Name Conflicts” on page 29.

Updating an Action List
Follow these steps to update an action list that exists on Workfolder Application Facility.

1. Make sure that you have checked out the action list. If not, select the icon
representing the action list you want to change and select Check out from the
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Selected pull-down in the Action Lists container window. The icon contains a
check mark to indicate that the action list is checked out.

2. Double-click on the icon. You can also select the action list icon and then select
Open from the Selected pull-down. You see the Action List window shown in
Figure 22 on page 37.

The window displays the information that was saved the last time the action list
was saved locally or checked in to Workfolder Application Facility.

3. Update the fields as described in “Creating an Action List” on page 37. You can
change all of the fields except the Name entry field and the Type radio buttons.

4. After you make all of your changes, click on one of the following push buttons:

Save To save the information for this action list and close the window
without checking in the action list. The information is saved locally on
your workstation. Work Management Builder verifies the information in
the window for valid values before saving the action list.

Check in  To save the information for this action list, check in the action list, and
close the window. Work Management Builder verifies the information in
the window for valid values before checking in the action list. This
push button is available only if you are logged on to Workfolder
Application Facility.

Cancel To cancel the Action List window without saving changes to the action
list.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Browsing an Action List

You can open an action list in browse mode that you have not checked out. However,
you cannot change any of the fields. See “Working in Different Edit Modes” on page 25
for a description of Work Management Builder editing modes.

To browse an action list:

1. Double-click on the icon representing the action list you want to browse in the
Action Lists container window. You can also select the action list icon and then
select Open from the Selected pull-down. You see the Action List window shown
in Figure 22 on page 37.

2. When you have finished viewing the action list, click on one of the following push
buttons:

Check out To check out the action list if you are working in browse mode without
closing the window. The data is refreshed with the most recent data
from Workfolder Application Facility. The Action List window switches
from browse mode to update mode, and you can make changes to the
action list. This push button is available only if you are logged on to
Workfolder Application Facility.
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Cancel To cancel the Action List window.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Closing an Action List

To close an action list, select Close from the title bar pull-down in the Action List
window. You are prompted to save any data that has not been saved.

¢ Click on the Yes push button to save the information for the action list and close
the window. Work Management Builder verifies the information in the window for
valid values before saving the action list.

¢ Click on the No push button to close the Action List window without saving the
changes. If the action list has never been saved, an unnamed icon is displayed in
the Action Lists window. This icon represents the action list that you did not save.
When you close the Action Lists container window, the icon is removed.
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Chapter 6.

Working with Workbaskets

A workbasket is a point in a work process where work packages are handled. A
workbasket contains work packages to be worked on by a user. When documents are
in a workbasket, they are available for a user to work on them.

The rules for work and the method of work selection are

part of the workbasket

definition. For example, a workbasket can represent the in-basket of an individual user,
a shared stack of sorted reports, or a table of correspondence.

In Work Management Builder, each workbasket is an object that is represented by a
workbasket icon. These workbasket objects are defined and displayed in the
Workbaskets container window. See Figure 23 for a sample Workbaskets container

window.

12 \workbaskets

Selected Edit View Help

APPRYLTR EXCEPT EXCEPTI: FINALRYW  INIT

4

PROCAPP PROCCHDET REJECTLTR WwORKBACK2

Figure 23. Workbaskets Container Window

From the Workbaskets container window, you can open,
in existing workbaskets and create nhew workbaskets.

check out, release, and check

Creating a Workbasket

42

To create a new workbasket:

1. Double-click on the Workbaskets icon in the Work Management Builder window.
You can also select the Workbaskets icon, then select Open from the Selected
pull-down. You see the Workbaskets container window shown in Figure 23.

2. Select Create another from the Edit pull-down. You see the Workbasket window

shown in Figure 24 on page 43.
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Figure 24. Workbasket Window

3. Type the name for the new workbasket in the Name entry field. You can type up

to 10 characters, including digits and special symbols. The name must be unique
for a workbasket. The name is displayed in uppercase letters when you save the
workbasket or check it in. This is a required field.

. Type a description for the workbasket in the Description entry field. You can type
up to 30 characters, including digits and special symbols. This is a required field.

. Use the Security spin button to select a security code level, or type a security
level. You can select from 0 to 999. This field controls a user’s access to the
workbasket. A user can access the workbasket only if the security value of the
workbasket falls within the user’s security range. The Workfolder Application
Facility system administrator defines a security range for users in their user 1D
profiles. For more information on user ID profiles, see the IBM ImagePlus
Workfolder Application Facility for AS/400: System Administration Guide. The
default value for a new workbasket is 0.

. Select a History log level from the Log levels group box. During logging,
Workfolder Application Facility accumulates and stores information about the
activities associated with each work package. You can select:

Work package history not logged
To not record work package history.

Log GET, PUT, REMOVE, RETURN
To record information each time a work package is assigned to a workbasket,
retrieved from a workbasket, returned to a workbasket, and removed from a
workbasket.
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Level 1 and workbasket keys
To record information each time a work package is assigned to a workbasket,
retrieved from a workbasket, returned to a workbasket, and removed from a
workbasket. This choice also logs each time a function key is used.

Level 2 and workbasket options
To record information each time a work package is assigned to a workbasket,
retrieved from a workbasket, returned to a workbasket, and removed from a
workbasket. This choice also logs each time a function key or option code is
used.

If you cannot see all of the text in the drop-down list, use the horizontal and vertical
scroll bars to display any additional text.

The default value for a new workbasket is Log GET, PUT, REMOVE, RETURN.
This is a required field.

At runtime, you can access this information using Application System/400 (AS/400)
Query, an IBM licensed program that produces reports from information selected
from the Workfolder Application Facility data files.

7. Select a User activity log level from the Log levels group box. During logging,
Workfolder Application Facility accumulates and records information each time a
user accesses the workbasket or uses a function key. You can select:

User activity not logged
To not log user activity.

Log after complete workbasket
To log user activity only after the user completes all workbasket processing and
exits the workbasket.

Log after complete function
To log user activity only after the user completes each workbasket function, but
before the user exits the workbasket.

If you cannot see all of the text in the drop-down list, use the horizontal and vertical
scroll bars to display any additional text. The default value for a new workbasket is
Log after complete workbasket . This is a required field.

8. Type keywords that you want to be stored in a Workfolder Application Facility
workbasket history file along with user activity and work package logging
information in the Report key entry fields. These keywords can help you query the
workbasket log files. You can type up to 15 characters, including digits and special
symbols, in each of the three entry fields. These entry fields are not available if you
select Work package history not logged  from the History drop-down list and
User activity not logged from the User activity drop-down list. These keywords
are displayed in uppercase letters when you save the workbasket or check it in.

9. Select a workbasket type in the Type field. The number in parentheses after each
workbasket type is the number assigned to the workbasket type on Workfolder
Application Facility. You can select:
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10.

11.

Scan documents (01)
To create a workbasket that accepts documents from the scanner and starts
them on a work process.

Index folder documents (02)
To create a workbasket that accepts documents that have been scanned into the
system and are waiting to be indexed into Workfolder Application Facility folders.

Index documents (03)
To create a workbasket that accepts documents that have been scanned into the
system and are waiting to be indexed into a Workfolder Application Facilityfile
cabinet.

Folder scan and index (04)
To create a workbasket that accepts Workfolder Application Facility documents
from the scanner, indexes them into folders, and starts them on a work process.

Document scan and index (05)
To create a workbasket that accepts Workfolder Application Facility documents
from the scanner, indexes them into file cabinets, and starts them on a work
process.

Work with work packages (06)
To create a workbasket that displays a list of the documents in the folder or
information related to a single document in a file cabinet.

User-defined (50-99)
To create a workbasket that calls a user exit. Workfolder Application Facility
numbers these workbaskets sequentially from 50 to 99.

Workfolder Application Facility defines workbasket types. The selection you make
in the Type field determines the choices that are available in the group box below
the Type field. This choice is not available when you open a workbasket in update
mode. For more information on Work Management Builder editing modes, see
“Working in Different Edit Modes” on page 25. The default value for a new
workbasket is Work with work packages . This is a required field.

Select a work process name from the Work process drop-down list. This choice is
available for the following workbasket types:

e Scan documents (01)

e Folder scan and index (04)

¢ Document scan and index (05)
¢ User-defined (50-99)

The default value for a new workbasket is None. The value you select for Work
process is used as the default value by Workfolder Application Facility for
scanning and indexing. This field is optional.

Select a document type from the Document type drop-down list. Document types
are defined on Workfolder Application Facility. This choice is available for the
following workbasket types:

e Scan documents (01)
¢ Index folder documents (02)
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¢ Index documents (03)

¢ Folder scan and index (04)

¢ Document scan and index (05)
e User-defined (50-99)

The value you select for Document type is used as the default value by
Workfolder Application Facility for scanning and indexing. The default value for a
new workbasket is None. This field is required for Scan documents and optional
for the other valid types.

12. Select a file cabinet code from the File cabinet drop-down list. File cabinet codes
are defined on Workfolder Application Facility. This choice is available for the
following workbasket types:

¢ Index documents (03)
e Document scan and index (05)
e User-defined (50-99)

The value you select for File cabinet is used as the default value by Workfolder
Application Facility for scanning and indexing. The default value for a new
workbasket is None. This field is optional.

13. Select the name of an action list from the Action list drop-down list. Only action
lists that are appropriate to the type of workbasket you select are listed. Index
action lists are available for the following workbasket types:

¢ Index folder documents (02)

¢ Index documents (03)

e Folder scan and index (04)

e Document scan and index (05)

Work action lists are available for the following workbasket type:
e Work with work packages (06)

Both index action lists and work action lists are available for the following
workbasket type:

e User-defined (50-99)

If you select a new action list as the default for the workbasket, you are prompted
to check in the new action list before you check in the workbasket. The default
value for Action list is the first action list in the list. This field is optional for
User-defined and required for the other valid types.

14. Select a work order from the Work order drop-down list. This choice is available
for the following workbasket types:

¢ Index folder documents (02)

¢ Index documents (03)

e Work with work packages (06)
¢ User-defined (50-99)

You can select:
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15.

16.

17.

18.

First-in first-out To dispatch work packages in the workbasket in the order
in which they arrive.

Last-in first-out To dispatch the last work package in the workbasket to
arrive first.
Priority To dispatch work packages in the workbasket according to

the priority they were assigned when they were created.

This field is optional for User-defined and required for the other valid types. The
default value for a new workbasket is First-in first-out .

Click on the Scan before index check box if you want to scan the documents in
the workbasket before they are indexed. If you want to scan the documents in the
workbasket after they are indexed, leave the check box blank. This choice is
available for the following workbasket types:

¢ Folder scan and index (04)
¢ Document scan and index (05)
e User-defined (50-99)

The default value for a new workbasket is blank.

Click on the List work package check box if you want to display a list of all work
packages at this workbasket so that the user can select any work package in
random order. Leave the check box blank if you want to display the work packages
to the user in the order you specify in the Work order field. This choice is available
for the following workbasket types:

¢ Index folder documents (02)

¢ Index documents (03)

e Work with work packages (06)
e User-defined (50-99)

The default value for a new workbasket is blank.

Click on the Allow reassign to check box if you want the user to reassign work
packages to this workbasket. If you do not want users to reassign work packages
to this workbasket, leave the check box blank. This choice is available for the
following workbasket types:

¢ Index folder documents (02)

¢ Index documents (03)

¢ Work with work packages (06)
¢ User-defined (50-99)

The default value for a new workbasket is blank.
Click on one of the following push buttons:

Save To save the information for this workbasket and close the window
without checking in the workbasket. The information is saved locally on
your workstation. Work Management Builder verifies the information in
the window for valid values before saving the workbasket.
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Check in  To save the information for this workbasket, check in the workbasket,
and close the window. Work Management Builder verifies the
information in the window for valid values before checking in the
workbasket. This push button is available only if you are logged on to
Workfolder Application Facility.

Check out To check out the workbasket if you are working in browse mode
without closing the window. The data is refreshed with the most recent
data from Workfolder Application Facility. The Workbasket window
switches from browse mode to update mode, and you can make
changes to the workbasket. This push button is available only if you
are logged on to Workfolder Application Facility.

Cancel To cancel the Workbasket window without saving changes to a
workbasket. An unnamed icon is displayed in the Workbaskets
window. This icon represents the workbasket that you cancelled.
When you close the Workbasket container window, the icon is
removed.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Renaming a Workbasket

When you create a new workbasket, you must give it a unique name. If a workbasket
with the same name already exists on your workstation, you are prompted to change
the name of the new workbasket when you click on the Save or the Check in push
button in the Workbasket window.

If a workbasket with the same name already exists on Workfolder Application Facility,
you are prompted to change the name when you click on the Check in push button in
the Workbasket window, or select Check in from the Selected pull-down in the
Workbaskets container window. For more information on changing the name of a
workbasket, see “Resolving Name Conflicts” on page 29.

Updating a Workbasket
To update an existing workbasket:

1. Make sure you have checked out the workbasket. If not, select the icon
representing the workbasket you want to change and select Check out from the
Selected pull-down in the Workbaskets container window. The icon contains a
check mark to indicate that the workbasket is checked out.

2. Double-click on the icon. You can also select the workbasket icon, then select
Open from the Selected pull-down. You see the Workbasket window shown in
Figure 24 on page 43. The window displays the information that was saved the
last time the workbasket was saved locally or checked in to Workfolder Application
Facility.
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3. Update the fields as described in “Creating a Workbasket” on page 42. You can
change all of the fields except the Name entry field and the Type drop-down list.

4. When you have made all of your changes, click on one of the following push

buttons:

Save

Check in

Cancel

To save the information for this workbasket and close the window
without checking in the workbasket. The information is saved locally on
your workstation. Work Management Builder verifies the information in
the window for valid values before saving the workbasket.

To save the information for this workbasket, check in the workbasket,
and close the window. Work Management Builder verifies the
information in the window for valid values before checking in the
workbasket. This push button is available only if you are logged on to
Workfolder Application Facility.

To cancel the Workbasket window without saving changes to the
workbasket.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Browsing a Workbasket

You can open a workbasket in browse mode that you have not checked out. However,
you cannot change any of the fields. See “Working in Different Edit Modes” on page 25
for a description of Work Management Builder editing modes.

To browse a workbasket:

1. Double-click on the icon representing the workbasket you want to browse in the
Workbaskets container window. You can also select the workbasket icon, then
select Open from the Selected pull-down. You see the Workbasket window shown
in Figure 24 on page 43.

2. When you have finished viewing the workbasket, click on one of the following push

buttons:

Check out To check out the workbasket without closing the window. The data is

Cancel

refreshed with the most recent data from Workfolder Application
Facility. The Workbasket window switches from browse mode to
update mode, and you can make changes to the workbasket. This
push button is available only if you are logged on to Workfolder
Application Facility.

To cancel the Workbasket window.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.
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Closing a Workbasket

To close a workbasket, select Close from the title bar pull-down in the Workbasket
window. You are prompted to save any data that you have not yet saved.

¢ Click on the Yes push button to save the information for the workbasket and close
the window. Work Management Builder verifies the information in the window for
valid values before saving the workbasket.

e Click on the No push button to close the Workbasket window without saving the
changes. If the workbasket has never been saved, an unnamed icon is displayed in
the Workbaskets window. This icon represents the workbasket that you did not
save. When you close the Workbaskets container window, the icon is removed.
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Chapter 7.
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Working with Work Processes

The Workfolder Application Facility work management process lets you automate your
flow of work by creating work processes. A work process is a set of functions that
defines the rules and paths through which a work package flows. A work package
consists of one or more documents that move together from one place to another in a
work process. For example, a work package might contain a loan application, a credit
report, and an appraisal statement.

¢ A collection point is a place in a work process that holds a work package for a
specified time or reason. After certain criteria are met, the work package is sent to
the next step in the work process.

¢ A decision pointis a place in a work process that determines the path that a work
package follows based on criteria that you define. For example, these choices can
be based on line-of-business data, work management data, or the function key the
user pressed.

e A path describes the flow of a work package within a work process. A path can
also integrate the flow of work with a line-of-business application through user
exits. You can use the Work Management Builder work process editor to create a
graphical representation of the paths a work package takes through a work
process.

In Work Management Builder, each work process is an object that is represented by a
work process icon. These work process objects are defined and displayed in the Work

Processes container window. A sample Work Processes container window is shown in
Figure 25.
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Figure 25. Work Processes Container Window

From the Work Processes container window, you can open, check out, release, and
check in existing work processes, and create new work processes.
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Creating a Work Process
To create a new work process:

1. Double-click on the Work Processes icon in the Work Management Builder window.
You can also select the Work Processes icon, then select Open from the Selected
pull-down. You see the Work Processes container window shown in Figure 25 on
page 51.

2. Select Create another from the Edit pull-down. You see the Work Process window
shown in Figure 26. The title bar of the window reads New Work Process to
indicate that you are in create mode. For more information on Work Management
Builder editing modes, see “Working in Different Edit Modes” on page 25.

Mew Work Process - Lintitled
“Work process Selected Edit View Options Settings Help

0

-

Z

Figure 26. Work Process Window

3. Make sure that the size and orientation of your drawing surface are correct for your
work process diagram. For more information on specifying the size of the drawing
surface, see “Changing the Size of the Drawing Surface” on page 82.

4. Use the Work Process window to create a graphical representation of a work
process, which is composed of nodes and connectors that specify the components
of the work process and its path. A detailed description of the Work Process
window and the procedures for creating a work process is contained in Chapter 8,
“Using the Work Process Window” on page 56.

5. Specify a name and description for the work process. For more information on
naming a work process, see “Naming a Work Process” on page 76.
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6. Verify the work process after you create and name it. See “Verifying a Work
Process” on page 77 for information on verifying the work process.

7. Select one of the following from the Work process pull-down:

Save work process
To save the information for this work process with its current name. The
information is saved locally on your workstation.

Save work process as
To save the information for this work process with a different name. The
information is saved locally on your workstation.

Check in
To save the information for this work process and check in the work process.
This selection is available only if you are logged on to Workfolder Application
Facility. Work Management Builder verifies the work process diagram before it is
checked in to Workfolder Application Facility.

Context-sensitive help is always available. Press F1 to display online help.

Renaming a Work Process

When you create a new work process, you must give it a unique name. If a work
process with the same name already exists on your workstation, you are prompted to
change the name of the new work process when you select Save work process or
Save work process as from the Work process pull-down in the Work Process
window.

If a work process with the same name already exists on Workfolder Application Facility,
you are prompted to change the name of the new work process when you select
Check in from the Selected pull-down in the Work Processes container window, or
from the Work process pull-down in the Work Process window. For more information
on changing the name of a work process, see “Resolving Name Conflicts” on page 29.

Updating a Work Process
To update a work process that exists on Workfolder Application Facility:

1. Make sure that you have checked out the work process. If not, select the icon
representing the work process you want to change and select Check out from the
Selected pull-down in the Work Processes container window. The icon contains a
check mark to indicate that the work process is checked out.

2. Double-click on the icon. You can also select the work process icon and then
select Open from the Selected pull-down. You see the Work Process window
shown in Figure 26 on page 52. The title bar of the window reads Update Work
Process to indicate that you are in update mode. For more information on Work
Management Builder editing modes, see “Working in Different Edit Modes” on
page 25.
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3. Update the work process diagram as described in Chapter 8, “Using the Work
Process Window” on page 56.

4. Verify the work process after you have made all of the changes. See “Verifying a
Work Process” on page 77 for information on verifying the work process.

5. Select one of the following from the Work process pull-down:

Save work process
To save the information for this work process with its current name. The
information is saved locally on your workstation.

Save work process as
To save the information for this work process with a different name. The
information is saved locally on your workstation.

Check in
To save the information for this work process and check in the work process.
This selection is available only if you are logged on to Workfolder Application
Facility. Work Management Builder verifies the work process diagram before it is
checked in to Workfolder Application Facility.

Context-sensitive help is always available. Press F1 to display online help.

Browsing a Work Process

You can open a work process in browse mode that you have not checked out. You

can make minor changes to the work process diagram in browse mode (for example,
cut, copy, paste, and move). You can then save the changed work process diagram

with a different name. To browse a work process:

1. Double-click on the icon representing the work process you want to browse in the
Work Processes container window. You can also select the work process icon and
then select Open from the Selected pull-down. You see the Work Process
window shown in Figure 26 on page 52. The title bar of the window reads Browse
Work Process to indicate that you are in browse mode. For more information on
Work Management Builder editing modes, see Chapter 8, “Using the Work
Process Window” on page 56.

2. When you have finished viewing the work process or making minor changes, select
one of the following:

Save work process as from the Work process pull-down
To save the information for this work process with a different name. The
information is saved locally on your workstation. The title bar of the window
changes to New Work Process to indicate that you are working with a new
work process.

Check out from the Work process pull-down
To check out the work process without closing the Work Process window. The
data is refreshed with the most recent data from Workfolder Application Facility.
The title bar of the window changes to Update Work Process to indicate that
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you are in update mode. You can make changes to the work process with its
existing name.

This choice is available only if you are logged on to Workfolder Application
Facility.

Close from the title bar pull-down
To close the Work Process window.

Closing a Work Process

To close a work process, select Close from the title bar pull-down in the Work Process
window. You are prompted to save any data that you have not yet saved.

¢ Click on the Yes push button to save the data for the work process and close the
window.

¢ Click on the No push button to close the Work Process window without saving the
changes. If the work process has never been saved, an unnamed icon is displayed
in the Work Processes window. This icon represents the work process that you did
not save. When you close the Work Processes container window, the icon is
removed.

e Click on the Cancel push button to keep the Work Process window open.
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Chapter 8.
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Using the Work Process Window

A work process diagram is a graphical representation of the flow of work within an
enterprise. The diagram is composed of nodes and connectors. The nodes define the
locations where a work package is processed or assembled, and the connectors define
the path that the work package takes through the work process.

The Work Process window provides the tools you need to interactively lay out a
diagram that defines your work process. You can use the drawing surface to create,
update, and display a work process. This area can be zoomed and scrolled.

Each new work process diagram contains a begin node. For information on moving this
node to a different location, see “Moving a Node” on page 63.

As shown in Figure 27, the Work Process window can contain the following additional
windows:

e Tool Palette
e Overview
e Clipboard View

| Clipboard View .

Options Help
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DECISION = i o
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Tool Palette

Figure 27. Work Process, Tool Palette, Clipboard View, and Overview Windows

e The Tool Palette window contains the tools that you need to lay out the diagram
that defines your work process, as shown in Figure 28 on page 57.
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Figure 28. Tool Palette Window

The first nine tools in the window let you create nodes in your diagram. The
remaining tool lets you create a connector that connects two nodes and indicates
the path that information takes through the work process. For information on using
the nodes and connectors in the Tool Palette window, see “Using Nodes and
Connectors.”

The Overview window shows the entire diagram that you are creating or updating.
For information on displaying the Overview window, see “Using the Overview
Window” on page 84.

The Clipboard View window displays the contents of the clipboard. For information
on displaying the Clipboard View window, see “Using the Clipboard View Window”
on page 86.

Using Nodes and

Connectors

Your work process diagram is made up of nodes and connectors, which specify the
components of the work process and its path. You can use the following nodes and
connectors to create or update your work process diagram:

G,
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A begin node begins the work process. A begin node indicates how the work
process is initiated when it is run on Workfolder Application Facility.

Every new work process diagram contains a begin node. However, you can
delete this begin node and add another if you want to position it somewhere else
in your work process diagram. The work process diagram must have one and
only one begin node.

A begin node can represent a scanner or a line-of-business application, or it can
represent a user action. The appearance of the begin node in your work process
diagram is determined by how the work process is initiated. For more information
on describing a begin node, see “Describing a Begin Node” on page 66.

A work node associates a workbasket and an action list for a specific point in a
work process. A work node represents a point in the work process where work is
performed.

For more information on describing a work node, see “Describing a Work Node”
on page 66.

A user exit node lets a work process call a line-of-business application. Values
from the work process can then be passed to the line-of-business application,
and control values from the line-of-business application can be passed back to
the work process.

For more information on describing a user exit node, see “Describing a User Exit
Node” on page 68.
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A decision point node selects the next step in the work process. Decision
branches choose the path that the work process follows based on
line-of-business information, work management information, or the function key a
user uses.

For more information on describing a decision point node, see “Describing a
Decision Point Node” on page 68.

A collection point node collects information from different sources before passing
it on. A collection point holds and manages work packages that cannot be
processed completely until additional information is received.

For more information on describing a collection point node, see “Describing a
Collection Point Node” on page 70.

A document node represents a document in the work process. The document
IB types that are available are defined on Workfolder Application Facility. A
document node can only be connected to a collection point node.

For more information on describing a document node, see “Describing a
Document Node” on page 72.

A customer-defined event node represents an event in the work process that is
triggered by a line-of-business application through a call to a Workfolder
Application Facility Match Collection Point (MATCHCP) application programming
interface (API). For more information on the MATCHCP API, see IBM ImagePlus
Workfolder Application Facility for AS/400: Programming Interfaces Guide.

The user specifies the event type, which is a value from 50 to 99, and text
representing the match criterion for the event. A user-defined event node can
only be connected to a collection point node.

For more information on describing a user-defined event node, see IBM
ImagePlus Workfolder Application Facility for AS/400: Programming Interfaces
Guide.

An assign value node copies a value into a work process variable. This variable
can then be accessed later in the work process by a succeeding step or by a
user exit program.

For more information on describing an assign value node, see “Describing an
Assign Value Node” on page 74.

A stop node stops the work process. A stop node indicates how the work process
is stopped when it is run on Workfolder Application Facility.

A stop node can represent a transfer to a case processing queue, a queue of
closed cases, or simply the ending of a work process. The appearance of the
stop node in your work process diagram is determined by how the work process
is stopped.

For more information on describing a stop node, see “Describing a Stop Node” on
page 75.

— A connector connects a source node to one or more target nodes. At the target
node end, an arrowhead is displayed that points to the target node. A decision
branch connector also displays its variable and value condition along the
connector.
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You can use the following connectors to create or update your work process diagram:

Decision branch connector
Represents the decision choice and path to be taken from a decision point node
when the value of the variable associated with the decision point matches the value
associated with the decision branch.

Exception branch for a decision point connector
Represents the decision choice and path to be taken from a decision point node
when the value of the variable associated with the decision point does not match any
values associated with the decision branches of the decision point. A solid rectangle
is displayed at the source end of the exception connector to distinguish it from other
connectors.

Collection point event list branch connector
Represents the path to be taken from a collection point node when selected events
are complete.

Exception branch for a collection point connector
Represents the path to be taken from a collection point node in the exception
condition where a maximum time period has ended and the selected events are not
complete. A solid rectangle is displayed at the source end of the exception connector
to distinguish it from other connectors.

Directional connector
Indicates the path to be taken when the selected events are complete.

Parallel connector
Specifies parallel processing to begin. The connector is made up of one source
branch and many target branches. Work Management Builder automatically creates
this connector and replaces multiple outbound connectors that have the same source
node and satisfy the same condition and function.

Creating a Node

A node is composed of a symbol and possibly a text label. For a work, collection point,
decision point, document, user-defined event, user exit, or stop (queue) node, its name
is displayed in a text label. For an assign value node, the variable and value are
displayed in the text label.

To create a node:

1. Move your mouse pointer over the node that you want to create in the Tool Palette
window.

2. Press and hold mouse button 2. This selects the node. Drag the node to the
drawing surface and position it where you want it to appear in the work process
diagram. The node is displayed as an outlined shape. If you select and drag the
wrong node, you can clear it by pressing Esc before you release mouse button 2.

3. Release mouse button 2. The node is positioned in the work process diagram.
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To specify additional information about a node, double-click mouse button 1 on the
node in the work process diagram. You can also select the node, then select Open
from the Selected pull-down. A window is displayed that allows you to specify
additional information about the node. You must be in create mode or update mode to
change the information in the window.

To deselect the selected node, double-click mouse button 1 on a blank area of the
drawing surface.

For more information on describing a node, see “Describing Nodes and Connectors” on
page 66.

Creating a Connector

A connector connects a source node to one or more target nodes. A connector can
also describe the criteria that determine the path your work process diagram takes from
a decision point node or a collection point node.

To create a connector:

1. Move your mouse pointer over the connector in the Tool Palette window.

2. Press and hold mouse button 2. The connector is selected. Drag the connector to
the drawing surface. The connector is displayed as a pencil.

3. Move the pencil over the middle of the source node on the work process diagram.
4. Release mouse button 2.

5. With no mouse button pressed, move the pointer over the middle of the target
node on the work process diagram.

6. Double-click mouse button 2 over the middle of the target node to complete the
action, or press Esc to cancel the action.

The connector is displayed as a line connecting the source node and the target node.
An arrow is displayed at the target end of the connector, pointing to the target node.

To specify additional information about a connector from a collection point node or a
decision point node, double-click mouse button 1 on the connector in the work process
diagram. You can also select the connector, then select Open from the Selected
pull-down. A window is displayed that allows you to specify additional information about
the connector. You must be in create mode or update mode to change the information
in the window.

To deselect the selected connector, double-click mouse button 1 on a blank area of the
drawing surface.

For more information on describing a connector, see “Describing Nodes and
Connectors” on page 66.
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Connecting Nodes

The work process editor has few restrictions on the types of nodes that you can
connect to each other. Table 2 on page 62 shows the nodes that you can connect with
an outbound connector.
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Manipulating Nodes and Connectors

You can manipulate a node or connector by dragging the node or connector with the
mouse or by using the menu bar selections. If you use a mouse, you can cancel a
procedure by holding down mouse button 2 while you press Esc.

You can also cancel your last editing procedure by selecting Undo from the Edit
pull-down. Undo is available after you drag a node or connector onto the drawing
surface. You can select Undo to cancel the following editing actions:

¢ Adding, deleting, moving, cutting, pasting, and sizing a node or connector
¢ Adding, deleting, and moving a bend point

¢ Changing the application information linked to a node or connector. If you select
Undo, the text label is changed back to its previous label and the icon form is
changed back to its previous form.

Moving a Node
To move a node by using the mouse:

1. Move the mouse pointer over the node that you want to move in the work process
diagram.

2. Press and hold mouse button 2. This selects the node. Drag the mouse pointer to
a different location on the drawing surface. The node is displayed as an outlined
shape.

3. Release mouse button 2. The node is redrawn at the new location. All of the
connectors attached to the node are reshaped and redrawn to show that they are
still attached to the node.

Some nodes can be displayed on top of one another in the work process diagram. You
can bring a selected node to the foreground or move it to the background. To move a
selected node in front of or behind other nodes, select Place in foreground or Place
in background , respectively, from the Selected pull-down.

Clearing a Node
You can clear a node from the work process diagram and temporarily store a copy of
the node in the clipboard, or you can clear the node without storing a copy in the
clipboard. If you store a copy in the clipboard, you can use the node again in your work
process diagram.

Clearing a Node without a Copy to the Clipboard
To clear a node without storing a copy in the clipboard:

1. Click on the node that you want to clear in the work process diagram to select it.

2. Select Clear from the Edit pull-down. The node and the connectors attached to it
are cleared from the work process diagram.
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Clearing a Node with a Copy to the Clipboard

To clear a node and store a copy in the clipboard:
1. Click on the node that you want to clear in the work process diagram to select it.
2. Select Cut from the Edit pull-down. The node is deleted from the diagram and
placed in the clipboard.

Note that only the node is copied to the clipboard, not its connectors, unless you select
the node and its connectors together.

To use the node again in the work process diagram:

1. Select Paste from the Edit pull-down. The node is displayed again as an outlined
shape.

2. Use the mouse to reposition the node in the work process diagram. The mouse
pointer is shaped like a paintbrush.

3. Click mouse button 2 to position the node in the work process diagram.

You can use Cut and Paste to position the same node in more than one place in the
work process diagram. The node you cut remains in the clipboard until you select
another node and use Cut or Copy again.

To display the contents of the clipboard, select Clipboard view from the Options
pull-down. For more information on the clipboard, see “Using the Clipboard View
Window” on page 86.

Copying a Node
You can copy nodes, connectors, or a combination of nodes and connectors from one
place to another in the work process diagram. To copy one or more nodes or
connectors:

1. Click on the node or connector that you want to copy in the work process diagram
to select it.

2. Select Copy from the Edit pull-down. The node or connector is copied to the
clipboard.

3. Select Paste from the Edit pull-down. The node or connector is displayed again as
an outlined shape.

4. Use the mouse to reposition the node or connector in the work process diagram.
The mouse pointer is shaped like a paintbrush.

5. Click mouse button 2 to position the node or connector in the work process
diagram.

Scaling a Node
To make a node smaller or larger:
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1. Select Size handles from the Options pull-down. All of the nodes in the work
process diagram display size handles, which are small squares defining the outside
edges of the node.

2. Click on the node that you want to size in the work process diagram to select it.
The size handles are also selected.

3. Position the mouse pointer on a small square on one of the corners of the node
you want to make smaller or larger.

4. Press and hold mouse button 2. Drag the small square toward the center of the
node to reduce it, or away to enlarge it.

5. To change the size and proportion of the node, drag a small square on the top or
side of the node, depending on how you want the node reproportioned.

6. Release mouse button 2. The node is redrawn in its new size and proportion. All of
the connectors attached to the node are reshaped and redrawn to show that they
are still attached to the node.

Adding a Bend in a Connector
You might want to add a bend in a connector to unclutter or streamline your work
process diagram. Figure 1 on page 4 shows bends in a number of the connectors,
including the connector between the CREDITRPT and WAITCREDIT nodes.

To add a bend in a connector:

1. Click on the connector to select it. The connector displays bend points, which are
small squares defining the beginning, end, and any bends in a connector. To
display bend points for all of the connectors in your work process diagram, select
Bend points from the Options pull-down.

2. Double-click mouse button 2 on the connector where you want to add a bend point.
You can also press and hold mouse button 2 on the connector, then move the
pointer where you want the bend point positioned. Release mouse button 2.

Moving a Bend in a Connector
You might want to move a bend in a connector to eliminate overlapping connectors in
your work process diagram. To move the bend point in a connector:

1. Click on the connector to select it. The connector displays bend points, which are
small squares defining the beginning, end, and any bends in a connector. To
display bend points for all of the connectors in your work process diagram, select
Bend points from the Options pull-down.

2. Position the mouse pointer on a small square on the bend in the connector that
you want to move.

3. Press and hold mouse button 2. Drag the small square to the new position in the
work process diagram. The connector is displayed again as a line that changes
shape as you reposition the bend point.

4. Release mouse button 2. The bend point is redrawn at the new location.
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Describing Nodes and Connectors

You can specify additional information about the nodes and connectors in your work
process diagram. For example, this information can describe the node or connector, or
define criteria for moving through the work process.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Describing a Begin Node
Follow these steps to specify where the work process is initiated.

1. Double-click mouse button 1 on the begin node symbol in the work process
diagram. As shown in Figure 29, you see the Begin Node window.

W Begin Node

work Process invoked by

7 Line of business

7 User

| 0K ”Cancel” Help |

Figure 29. Begin Node Window
2. Select the initiation point for the work process from the Work process invoked by
group box. You can select one of the following radio buttons:
Scanner  To initiate the work process from a scanner.

Line of business
To initiate the work process from a line-of-business application.

User To allow the user to initiate the work process.
3. Click on one of the following push buttons:
OK To save the values that you specify and close the Begin Node window.

Cancel To close the Begin Node window without specifying how the work
process is initiated.

Describing a Work Node

Follow these steps to associate a workbasket and action list with the selected work
node.

1. Double-click mouse button 1 on the work node in the work process diagram. You
see the Work Node window shown in Figure 30 on page 67.
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W ‘work Node

~workhasket to use

Workbasket | LOANREVIEWY 5

Type: Work with work packages

Description: Loan review

Action list to use |Default %

| oK ”Cancel§| Help i

Figure 30. Work Node Window

2. Select the name of a workbasket from the Workbasket drop-down list in the
Workbasket to use group box. The name is displayed below the node when you
click on the OK push button. The Type and the Description display fields change
automatically to reflect the workbasket you selected. The following workbasket
types are not used in a work node and are not included in the Workbasket
drop-down list:

e Scan documents (01)
¢ Folder scan and index (04)
e Document scan and index (05)

See Chapter 5, “Working with Action Lists” on page 36 for more information on
workbasket types.

3. If you do not want to use the default action list associated with the workbasket,
select another action list from the Action list to use drop-down list. Only action
lists appropriate to the type of workbasket you select are listed. Index action lists
are listed for Index folder documents (02) and Index documents (03) workbasket
types. Work action lists are listed for Work with work packages (06) workbasket
types. Both index and work action lists are listed for User-defined (50-99)
workbasket types. For more information on associating an action list with a
workbasket, see “Creating a Workbasket” on page 42.

4. Click on one of the following push buttons:

OK To save the values that you specify and close the Work Node window.
Cancel To close the Work Node window without describing the selected work
node.
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Describing a User Exit Node
Follow these steps to specify a hame for a user exit node.

1. Double-click mouse button 1 on the user exit node in the work process diagram.
You see the User Exit window shown in Figure 31.

User Exit

Program name |DEFAULT|

| 0K ”Cancel” Help |

Figure 31. User Exit Window

2. Type the program name for the user exit used on Workfolder Application Facility in
the Program name entry field. You can type up to 10 characters, including digits
and special symbols. The name is displayed in uppercase letters below the node
when you click on the OK push button. The default entry is DEFAULT.

3. Click on one of the following push buttons:

OK To save the value you specify and close the User Exit window.
Cancel To close the User Exit window without naming the selected user exit
node.

Describing a Decision Point Node

Follow these steps to specify a name and additional information about a decision point
node.

1. Double-click mouse button 1 on the decision point node in the work process
diagram. You see the Decision Point window shown in Figure 32.

W/ Decision Point

Mame || |

Description |

| 0K ”Cancel” Help |

Figure 32. Decision Point Window

2. Type the name for the decision point node in the Name entry field. You can type
up to 10 characters, including digits and special symbols. The name must be
unique for a decision point node. The name is displayed in uppercase letters below
the node when you click on the OK push button. This is a required field.
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3. Type a description for the decision point node in the Description entry field. You
can type up to 30 characters, including digits and special symbols. This is a
required field.

4. Click on one of the following push buttons:

OK To save the values that you specify and close the Decision Point
window.
Cancel To close the Decision Point window without describing the selected

decision point node.

For information on describing a connector from a decision point node, see “Describing a
Decision Point Connector.”

Describing a Decision Point Connector
Follow these steps to describe a connector from a decision point node.

1. Double-click mouse button 1 on the outbound connector from the decision point

node in the work process diagram. You see the Decision Branch window shown in
Figure 33.

W Decision Branch

~-Decision point details
Mame: LOANDESC

Description: Loan decision point

~-Condition criteria

Variable Value

@if *BUTTON o= 2%

%7 Exception condition

I OK ;]Cancelll Help I

Figure 33. Decision Branch Window

The Decision point details group box displays the name and a description of the
decision point source node for this decision branch.

2. Select a type of decision branch from the Condition criteria group box. The
condition criteria determine whether the work proceeds to the target node. Each
path from a decision point node is chosen based on the condition criteria being
met. You can select one of the following radio buttons:
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To have the decision branch examine the value of a variable for
meeting the condition. You must then select a Variable from the
drop-down combination list (*BUTTON, *PRIORITY, or a Workfolder
Application Facility defined variable), or type a variable.

If you select *BUTTON from the Variable drop-down list, the Value
field is a spin button, which you can use to select a number from 2 to
22, or type a number. The default value is 2. If you do not select
*BUTTON, the Value field is an entry field, where you can type up to
10 characters, including digits and special symbols. The first character
in a user-defined variable name cannot be an asterisk (*).

The Value field is required if you select the If radio button. The
variable name and value are displayed in uppercase letters along the
connector when you click on the OK push button.

Exception condition

To have the decision branch represent the exception condition of a
decision point. An exception condition describes the path that the work
process takes if the condition criteria are not met. You must define one
and only one exception connector from each decision point. The
exception connector has a thin solid rectangle at its source end.

3. Click on one of the following push buttons:

OK

Cancel

To save the values you specify and close the Decision Branch window.

To cancel the Decision Branch window without specifying decision
criteria.

Describing a Collection Point Node
Follow these steps to specify a name and additional information about a collection point

node.

1. Double-click mouse button 1 on the collection point node in the work process
diagram. You see the Collection Point window shown in Figure 34.

W Caollection Point

Mame

Description

| 0K ”Cancel” Help |

Figure 34. Collection Point Window

2. Type the name for the collection point node in the Name entry field. You can type
up to 10 characters, including digits and special symbols. The name must be
unique for a collection point node. The name is displayed in uppercase letters
below the node when you click on the OK push button. This is a required field.

70  Workfolder Application Facility V4.1: User's Guide for the Work Management Builder



3. Type a description for the collection point node in the Description entry field. You

can type up to 30 characters, including digits and special symbols. This is a
required field.

4. Click on one of the following push buttons:

OK To save the values that you specify and close the Collection Point
window.
Cancel To close the Collection Point window without describing the selected

collection point node.

For information on describing a connector from a collection point node, see “Describing
a Collection Point Connector.”

Describing a Collection Point Connector
Follow these steps to describe a connector from a collection point source node.

1. Double-click mouse button 1 on the outbound connector from the collection point

node in the work process diagram. You see the Collection Point Event List window
shown in Figure 35.

W Collection Point Event List

~Collection point details
| Name: PROCESWAIT

Description: Credit rpt. and appraisal

Event list description | Credit report and appraisal

-Type of event list

@ waiting for events Collection point events
APPRAISAL m {APPRAISAL
‘CREDITRPT ICREDITRPT

7% waiting for maximum period

i

gdays i 8%

I OK ;]Cancelll Help I

Figure 35. Collection Point Event List Window
You can use this window to define a path for the collection point node. The
Collection point details  group box displays the name and a description of the
collection point source node.
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2. Type a description of the events associated with the collection point node in the
Event list description  entry field. You can type up to 30 characters, including
digits and special symbols. This is a required field.

3. Define your event list using the choices in the Type of event list group box. You
can select one of the following radio buttons:

Waiting for events
To create a list of events that must take place before the work package moves
on in the work process. The Collection point events  list box displays a list of all
nodes connected to a collection point that have information associated with
them. Select an event from this list, then click on the Add push button to add the
event to your list. To delete an event from the Waiting for events list box, select
the event from this list, then click on the Delete push button. Collection point
events, Waiting for events , the Add push button, and the Delete push button
are not available unless you select the Waiting for events radio button.

Waiting for maximum period
To have the event list branch represent the exception condition of a collection
point. Use the spin button to select the number of days before the work process
continues down this path. You can select a number from 0 to 999, or type a
number. The default value is 1. This spin button is not available unless you
select the Waiting for maximum period  radio button. You must define one and
only one exception connector from each collection point. This branch of the
work process is used only if all of the event lists from this collection point are not
complete before the selected number of days. The exception connector has a
thin solid rectangle at its source end.

4. Click on one of the following push buttons:

OK To save the values you specify and close the Collection Point Event
List window.

Cancel To cancel the Collection Point Event List window without specifying an
event list.

Describing a Document Node
Follow these steps to specify a name and additional information about a document
node.

1. Double-click mouse button 1 on the document node in the work process diagram.
You see the Document window shown in Figure 36 on page 73.
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W Document
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Figure 36. Document Window

2. Type the name for the document node in the Name field. You can type up to 10
characters, including digits and special symbols. The name is displayed in
uppercase letters below the node when you click on the OK push button. This is a
required field.

3. Select a document type from the Document type drop-down list. The document
types are defined in Workfolder Application Facility. You can select *ANY to
indicate that any document is accepted for this node. You can then select the
document from the Collection point events list box on the Collection Point Event
List window to indicate that any document satisfies the collection point criteria. For
more information on the Collection Point Event List window, see “Describing a
Collection Point Connector” on page 71.

4. Click on one of the following push buttons:
OK To save the values that you specify and close the Document window.

Cancel To close the Document window without describing the selected
document node.

Describing a User-Defined Event Node

Follow these steps to specify a hame and additional information about a user-defined
event node.

1. Double-click mouse button 1 on the user-defined event node in the work process
diagram. You see the User-defined Event window shown in Figure 37 on page 74.
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W User-defined Event
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Figure 37. User-defined Event Window

2. Type the name for the user-defined event node in the Name entry field. You can
type up to 10 characters, including digits and special symbols. The name is
displayed in uppercase letters below the node when you click on the OK push
button. This is a required field.

3. Use the Event type spin button to select a user-defined event type, or type a
number. You can select from 50 to 99. The default value is 50.

4. Type the user-defined data value to be matched in the Match criterion entry field.
This data value and the number you specify in the Event type field determine
whether the event is triggered at runtime by a call to a Workfolder Application
Facility MATCHCP API. For more information on the MATCHCP API, see IBM
ImagePlus Workfolder Application Facility for AS/400: Programming Interfaces
Guide.

You can type up to 40 characters, including digits and special symbols. This is a
required field.

5. Click on one of the following push buttons:

OK To save the values that you specify and close the User-defined Event
window.
Cancel To close the User-defined Event window without describing the

selected user-defined event node.

Describing an Assign Value Node
Follow these steps to specify a variable and a value for an assign value node.

1. Double-click mouse button 1 on the assign value node in the work process
diagram. You see the Assign Value window shown in Figure 38 on page 75.
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Figure 38. Assign Value Window

2. Select one of the following variables from the Variable drop-down combination list,
or type a variable:

*BUTTON To assign a button value to the assign value node.
*PRIORITY To assign a priority value to the assign value node.

You can also select any variables that were defined in Workfolder Application
Facility. If you select *BUTTON from the Variable drop-down list, the Value field is
a spin button, which you can use to select a number from 2 to 22, or type a
number. The default value is 2. If you do not select *BUTTON, the Value field is
an entry field, where you can type up to 10 characters, including digits and special
symbols. The first character in a user-defined variable name cannot be an asterisk
(*). The variable and value are displayed in uppercase letters below the node when
you click on the OK push button. This is a required field.

3. Click on one of the following push buttons:
OK To save the values you specify and close the Assign Value window.

Cancel To close the Assign Value window without assigning a value to the
selected assign value node.

Describing a Stop Node
Follow these steps to specify how the work process is stopped.

1. Double-click mouse button 1 on the stop node in the work process diagram. You
see the Stop Node window shown in Figure 39 on page 76.
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Figure 39. Stop Node Window

2. Select how the work process is stopped from the Type of stop node group box.
You can select one of the following radio buttons:

Stop To stop the work process.

Close To close a folder and put it in a closed queue. It is the same as
closing a case in Workfolder Application Facility processing. A close
node ends the current work process and the case is not put into any
workbasket or case processing queue.

Queue To put a folder into a Workfolder Application Facility case processing
queue. A queue is an entry into the case processing system.
Therefore, a queue ends the work process. Select a queue from the
Queue drop-down list. The queue names are defined on Workfolder
Application Facility.

3. Click on one of the following push buttons:
OK To save the values that you specify and close the Stop Node window.

Cancel To close the Stop Node window without specifying how the work
process is stopped.

Naming a Work Process

Each work process has a name and description associated with it. This name identifies
the work process to Workfolder Application Facility. To name a work process:

1. Select Work process details from the Work process pull-down. You see the
Work Process Details window shown in Figure 40 on page 77.
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Figure 40. Work Process Details Window

2. Type the name for the new work process in the Name entry field. You can type up
to 10 characters, including digits and special symbols. The name is displayed in
uppercase letters after you click on the OK push button. The name must be unique
for a work process. This is a required field.

3. Type a description for the work process in the Description entry field. You can
type up to 30 characters, including digits and special symbols. This is a required
field.

4. Click on one of the following push buttons:

OK To save the name you specify and close the Work Process Details
window.
Cancel To cancel the Work Process Details window without specifying a work

process name.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Verifying a Work Process

Work Management Builder automatically applies rules on how different nodes can be
connected in your work process. However, you should still verify that all of the
connections are valid. Some examples of connections that are not valid are:

¢ No begin node or stop node
¢ No direct or indirect path from a begin node to another node
¢ No outbound or inbound connectors for nodes that require them

Work Management Builder automatically verifies a new or updated work process
diagram before you check it in to Workfolder Application Facility. In addition, you can
verify your work process diagram at any time. To verify a work process diagram:

1. Select Verify diagram from the Work process pull-down. You see the Verify
window shown in Figure 41 on page 78.
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Figure 41. Verify Window

As the verification proceeds, the Percentage verified progress indicator shows the
percentage of the work process diagram that has been verified.

2. Check the Verification results list box for a list of any errors. If you need
additional information about an error message, select the message. Then press F1
or click on the Help push button. In addition, if the error can be shown in the Work
Process window, you can click on the Show push button to display the portion of
the work process diagram that contains the error. The associated incorrect nodes
or connectors are highlighted. You can then correct the error and return to the
Verify window. You might need to move the Verify window to select a message or
click on a push button.

Not all the messages listed in the Verification results list box prevent the work
process diagram from being verified successfully. Some messages might inform
you that workbaskets or action lists that the work process refers to need to be
checked in.

If you need to provide more information about a problem node or connector,
double-click on the node or connector to display the window associated with it. You
can also select the node or connector, then select Open from the Selected
pull-down.

If your work process diagram is successfully verified, an information message is
displayed in the Verification results list box.

3. Click on one of the following push buttons:
Stop To stop the verification process before it is complete.

Reverify To verify the work process again. You can use this push button after
you click on the Stop push button, or after the initial verification is
complete. For example, you can click on the Reverify push button
after you correct some or all of the errors in the Verification results
list box.
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Show To display the node or connector associated with the selected
message in the Work Process window. The node or connector is
highlighted in the Work Process window. You can correct the work
process diagram, then return to the Verify window. This push button is
not available if the node or connector cannot be displayed in the Work
Process window.

Cancel To close the Verify window whether or not verification is complete or
has been stopped.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Saving a Work Process
After you have created, named, and verified your work process, you must save it.
To save the work process with its current name, select Save work process from the

Work process pull-down. If you have not named your work process diagram, you see
the Save Work Process window shown in Figure 42.

W Save Work Process
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Figure 42. Save Work Process Window

1. Type the name for the work process in the Name entry field. You can type up to 10
characters, including digits and special symbols. The name is displayed in
uppercase letters after you click on the OK push button. The name must be unique
for a work process. This is a required field.

2. Type a description for the work process in the Description entry field. You can
type up to 30 characters, including digits and special symbols. This is a required
field.

3. Click on one of the following push buttons:

OK To save the work process with the name you specify and close the
Save Work Process window.

Cancel To cancel the Save Work Process window without saving the work
process.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.
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To save a copy of the work process with a different name:

1. Select Save work process as from the Work process pull down. You see the
Save Work Process As window shown in Figure 43.

W Save Work Process As
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Figure 43. Save Work Process As Window

2. Type the new name for the work process in the Name entry field. You can type up
to 10 characters, including digits and special symbols. The name is displayed in
uppercase letters after you click on the OK push button. The name must be unique
for a work process. This is a required field.

3. Type a new description for the work process in the Description entry field if you
want to change it. You can type up to 30 characters, including digits and special
symbols. This is a required field.

4. Click on one of the following push buttons:

OK To save a copy of the work process with the name you specify and
close the Save Work Process As window.

Cancel To cancel the Save Work Process As window without changing the
work process name.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Printing a Work Process Diagram

You can print the Workfolder Application Facility text translation of a work process
diagram, information associated with the work process, or the graphical representation
of the diagram itself.

Printing a Text Translation
If you do not verify a work process diagram, Work Management Builder prints only the
information associated with the work process, including the name and description of the
work process, the date and time of creation and the last update, whether the object is
checked out, and the user ID of the person who checked the object out.

If you verify a work process diagram, Work Management Builder translates certain
nodes and connectors to Workfolder Application Facility commands. The text translation
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of a work process diagram includes the Workfolder Application Facility commands and
the information associated with these nodes and connectors.

If you verify a work process diagram before you print it, Work Management Builder
prints this text translation in addition to the information that is printed if you do not verify
it.

To print a text translation or the information associated with the current work process
diagram:

1. Select Print textual format from the Work process pull-down in the Work Process
window. You see the Print Work Process window shown in Figure 44.

W Print ¥ork Process

Mumber of copies

I Print I]Cancel” Help |

Figure 44. Print Work Process Window
2. Select the number of copies you want to print using the Number of copies spin
button. You can print from 1 to 99 copies.
3. Click on one of the following push buttons:

Print To print the specified number of copies of the selected work process
on the default printer.

Cancel To close the Print Work Process window without printing the selected
work process.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Printing a Graphical Representation
To print a graphical representation of a work process diagram:

1. Select Print diagram from the Work process pull-down in the Work Process
window. You see the Print Diagram window shown in Figure 45 on page 82.
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Figure 45. Print Diagram Window

2. Select the area that you want to print from the Region group box. You can select
one of the following radio buttons:

Window To print the portion of the work process diagram that is displayed in
the Work Process window.

Diagram  To print the entire work process diagram.

3. Select one of the following radio buttons from the Zoom Factor group box to
define the size of the printout:
Fit on one page
To size the work process diagram to print on a single page.
Preserve

To print the work process diagram at its current size, regardless of whether you
have zoomed the diagram in or out. The size of the printed diagram matches the
size of the displayed diagram.

Actual

To print the work process diagram at its actual size, regardless of its size in the
Work Process window.

4. Click on one of the following push buttons:

OK To print the work process diagram with the selected options and close
the Print window.

Cancel To close the Print window without printing the work process diagram.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Changing the Size of the Drawing Surface

You can change the size of the drawing surface if you have a large work process
diagram that does not fit easily on the defined drawing surface. When you increase the
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size of the drawing surface, the percentage of the drawing surface that is visible on
your screen decreases.

You can use the horizontal and vertical scroll bars to adjust the portion of the drawing
surface that is displayed on your screen. You can also use the Overview window to
adjust the drawing surface. For more information on using the Overview window, see
“Changing the View” on page 85.

To change the size of the drawing surface:

1. Select Paper size from the Settings pull-down. You see the Define Paper Size
window shown in Figure 46.

DIN <y [594 X 1193 mm
DIN A2 (420 x 594 mm)]
DIN A3 297 x 420 mm)
DIN A4 (210 x 297 mm)
DIN A5 (148 x 210 mm)
DIN AB (105 x 148 mm)
A[8.50 x 11.00 in]

rOrientation
# Landscape 7 Portrait
I OK I lgpply] |Canct:l| 1 Help ]

Figure 46. Define Paper Size Window

2. Select one of the predefined sizes from the list box. The default value is the first
drawing surface size in the list.

3. Select either the Portrait or the Landscape radio button from the Orientation
group box. If you select the Portrait radio button, the available drawing surface is
longer than it is wide. If you select the Landscape radio button, the available
drawing surface is wider than it is long. Note that the choices in the Orientation
group box do not control the orientation of the paper in your default printer.

4. Click on one of the following push buttons:

OK To change the size and orientation of the drawing surface and close
the Define Paper Size window. The OK push button is unavailable if
the current work process diagram does not fit on the drawing surface
you selected. Select a bigger drawing surface or a different
orientation, or make the diagram more compact. For more information
on changing the size of the work process diagram before you print,
see “Printing a Work Process Diagram” on page 80.
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Apply To store the drawing surface size you specified in your user profile.
These values are used as the default size for this diagram and for
each new diagram you create.

A confirmation message box is displayed. Click on the OK push button
to confirm the change to your user profile.

Cancel To cancel the Define Paper Size window without changing the drawing
surface size.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Using the Overview Window

As shown in Figure 47, the Overview window shows the entire diagram that you are
creating or updating. This can be useful if you zoom the work process diagram so that
only a portion is visible on the drawing surface. You can also use the Overview window
to change the portion of the work process diagram that is displayed in the Work
Process window.

To open the Overview window, select Overview from the Options pull-down.

Options Help

Figure 47. Overview Window

To close the window, select Overview again.

Refreshing the Overview Window

You can set the frequency with which Work Management Builder refreshes the
Overview window. The more frequently you refresh the Overview window, the more
current the display. However, you might find that Work Management Builder
performance slows with frequent refreshing.

To set the refresh frequency:

1. Select Auto refresh from the Options pull-down in the Overview window. You see
the Define Overview Refresh Rate window shown in Figure 48 on page 85.
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Figure 48. Define Overview Refresh Rate Window

2. Check the Enable periodical refresh  check box to activate automatic refreshing of
the Overview window. If you leave the check box blank, the Overview window is
refreshed only when you make it the active window or you change the size of the
drawing surface.

3. Use the Minutes and Seconds spin buttons to select the time interval for the
automatic refresh.

4. Click on one of the following push buttons:

OK To accept the refresh rate change for the current diagram and close
the Define Overview Refresh Rate window.

Apply To store the refresh rate information in your user profile and keep the
window open.

Cancel To cancel the Define Overview Refresh Rate window without changing
the refresh rate.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.

Changing the View
You can manipulate the portion of your diagram that appears in the Work Process
window by adjusting the viewing frame, which is the dotted rectangle in the middle of
the Overview window. You can move the rectangle, which is the equivalent of scrolling
the window, or you can adjust the size of the rectangle, which zooms the window in
and out. Use mouse button 2 to move or adjust the viewing frame.

To display only the part of the drawing surface that contains the work process diagram
in the Overview window, select Used area from the Options pull-down. Select it again
to display the entire drawing surface.

Closing the Overview Window
To close the Overview window, select Exit overview from the Options pull-down. You
can also close the Overview window by selecting Overview from the Options
pull-down in the Work Process window.
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Using the Clipboard View Window

The clipboard is an area that temporarily holds information. Nodes and connectors that
you select before you select Cut or Copy from the Edit pull-down in the Work Process
window are stored in the clipboard. These nodes or connectors stay in the clipboard
until they are overwritten.

To display the contents of the clipboard, select Clipboard view from the Options
pull-down. You see the Clipboard View window shown in Figure 49.

I clpboardView |
Options  Help
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Figure 49. Clipboard View Window

From the Options pull-down in the Clipboard View window, you can select one of the
following:

Fit into window
To scale the nodes and connectors in the Clipboard View window so that
they all fit into one window.

Actual To display the nodes and connectors in the Clipboard View window in their
originally defined size.

Exit To close the Clipboard View window.

Zooming In and Out

You can change the portion of your diagram that appears in the Work Process window
by selecting one of the following from the View pull-down:

Zoom in To enlarge the display size of the diagram.

Zoom out To reduce the display size of the diagram. You can then
display more nodes in the Work Process window.

Zoom reset To restore the diagram to its original display size.

Note that zooming in and out affects the appearance of the text associated with each
node and some connectors. Zooming out can cause the text to be difficult to read.
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Displaying a Grid

You can display the drawing surface with or without a grid, measured in inches or
millimeters. You can use this grid to line up the nodes and connectors in the work
process diagram. To display a grid on the drawing surface:

1. Select Grid from the Settings pull-down. You see the Define Grid window shown

in Figure 50.
B2 Define Grid
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Figure 50. Define Grid Window

2. Select the Visible check box from the Options group box to display a grid on the
drawing surface. Select the Snap to grid check box if you want to center the
nodes only on the grid intersections. You can select one or both of these check
boxes.

3. Select either the mm (millimeter) or the inch radio button from the Spacing group
box to define the measurements of each cell in the grid.

4. Use the Vertical and Horizontal spin buttons to define the cell measurements, or
type the measurements. You can select from 5 to 50 millimeters, or from 0.2 to 2
inches. The cell in the window to the right of this field changes dynamically to
reflect your choices. You can also use mouse button 2 in this window to change
the size of the cell.

5. Click on one of the following push buttons:

OK To save the cell measurements you specified and close the Define
Grid window.

Defaults To reset the cell measurements to their default values.

Apply To store the cell measurements you specified in your user profile.
These values are used as the default cell measurements for this
diagram and for each new diagram you create. A confirmation
message box is displayed. Click on the OK push button to confirm the
change to your user profile.
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Cancel To cancel the Define Grid window without changing the cell
measurements.

Context-sensitive help is always available. Press F1 or click on the Help push button to
display online help.
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Appendix A. Using the Work Management Builder Tutorial

The Work Management Builder tutorial is designed to teach you about Work
Management Builder functions and then let you practice performing the functions. You
can use the tutorial independently of Work Management Builder and Workfolder
Application Facility. The tutorial explains how to check data in and out of Workfolder
Application Facility, but no real communications link is established.

The tutorial has the following features:

¢ You can interact with Work Management Builder, including sizing, positioning, and
controlling the program windows. At the same time, you can view tutorial
instructions in separate windows.

¢ You can use windows and hypertext links to move through the tutorial steps. A
hypertext link is an online connection between one piece of information and
another. Hypertext links are highlighted in the text.

Using the Tutorial Lessons
The tutorial contains the following starter lessons:

e Lesson 1 introduces the concepts that help you understand work process
management. The lesson describes the steps that can help you identify and outline
the processing that occurs in your business.

e Lesson 2 describes how to check action lists, workbaskets, and work processes in
and out of the Workfolder Application Facility host system. No real information is
checked in and out.

¢ Lesson 3 shows you how to open the Action List window and use the information
in the window to create and save a new action list, and modify an existing action
list.

e Lesson 4 shows you how to open the Workbasket window and use the information
in the window to create and save a workbasket.

In addition, the tutorial contains the following advanced lessons:

e Lesson 5 shows you how to create a work process diagram that contains a begin
node, a work node, and a connector. You learn how to work with the nodes and
connector in the Tool Palette, and how to provide information about the nodes you
create.

e Lesson 6 shows you how to add a document node and a collection point node to
your work process diagram. You learn how to define a collection point connector.

e Lesson 7 shows you how to expand your work process diagram by adding nodes
and connectors. You improve your ability to work with a diagram that contains an
increasing number of nodes and connectors. You also learn how to save the work
process diagram.
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¢ Lesson 8 shows you how to complete and verify the work process diagram. You
also learn how to define a decision point, and how to size a node to emphasize its
location in your diagram.

Starting the Work Management Builder Tutorial

If the Work Management Builder tutorial is not installed on your workstation, see
Chapter 2, “Installing Work Management Builder” on page 7, for complete instructions
on installing. To start the tutorial:

1. Double-click on the Work Management Builder Folder icon on the OS/2 desktop.
You see the IBM Work Management window shown in Figure 51.

wiork Management Builder Tutorial wWork, Management Builder

Figure 51. IBM Work Management Window

The IBM Work Management window contains the Work Management Builder icon
and the Work Management Builder Tutorial icon, if it is installed.

2. Double-click on the Work Management Builder Tutorial icon. You see the Work
Management Tutorial window shown in Figure 52 on page 91.
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Figure 52. Work Management Tutorial Window

3. Click on the Begin push button to start the Work Management Builder tutorial.

Interacting with Work Management Builder

Because the tutorial is not a simulation, you can experience the true look and feel of
Work Management Builder. The tutorial displays two windows on your screen. The
tutorial window on the left side of the screen presents lesson information. The right side
of the window is your working area, where you perform Work Management Builder
functions by following the tutorial instructions. See Figure 53 on page 92.
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Figure 53. Using the Tutorial Window

You can use the pull-down selections to display a list of tutorial windows, search for a
specific word, print or copy a tutorial lesson, display a list of lessons you have viewed,
begin the OS/2 online tutorial, and get online help. To display additional information
about using the tutorial, select Using the tutorial from the Help pull-down.

In addition, context-sensitive online help is always available for all pull-down choices
and push buttons. To display online help, move the cursor to the choice you want help
for, then press F1. Press Esc to close the help window.

Some tutorial windows have a Size push button. Click on the Size push button to
toggle the window display between horizontal and vertical viewing modes.

When you have finished the tutorial, you can reset the Work Management Builder
database used by the tutorial. Any object that you create is deleted, and any object that
you modify is restored to its original state. You can then use the tutorial again.

Before you reset the database used by the tutorial, first make sure that the tutorial is

not running on your workstation. Then type ehltrsdb at the OS/2 prompt and press
Enter.

Using Windows and Hypertext Links

The tutorial uses multiple window and hypertext links for presenting and structuring
tutorial information. The highest level of information in a Work Management Builder
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tutorial is a set of lessons, which groups related lessons with an overview and review.
See Figure 54 on page 93.
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Figure 54. Starter Lessons Overview Window
The lessons are related by topic (for example, creating a workbasket).

The tutorial format clearly separates different types of lesson information, but at the
same time shows how they fit together. Each lesson contains an overview and multiple
steps for performing the tasks of the lesson. The steps are further broken down into
individual actions. Instructions and notes are associated with each action that describe
the meaning or results of the action.

A hierarchical relationship exists between lessons and steps (lessons contain steps),
and a sequential relationship exists between steps (one step follows another). In
addition, each lesson has a concept associated with it. This concept parallels the
information in the lesson. The result is a combination of three types of tutorial windows:
lesson windows, step windows, and concepts windows.

Lesson Windows

Lessons windows include a short overview that describes the purpose and subject
matter of the lesson. See Figure 55 on page 94.
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Figure 55. Sample Lesson Window

At the beginning of each overview is a (Why?...) hypertext link that leads to an
explanation of the significance of that lesson. Hypertext links within this introductory
paragraph lead to a concepts window. Double-click on a hypertext link to display the
information associated with that link. Press Esc to return to the lesson window.

Lesson windows also include a numbered list of steps that you can follow to complete
the task of the lesson. Each step is a hypertext link to a step window.

The lesson window has Previous and Next lesson push buttons. Click on the
Previous push button to display the previous lesson. If you are on the first lesson, the
Previous push button displays the set overview. Click on the Next lesson push button
to display the next lesson in the set. If you are on the last lesson, you can click on the
Review lessons push button to display a review of the set.

Step Windows

The step window contains detailed information for each step. See Figure 56 on
page 95.

94  workfolder Application Facility V4.1: User's Guide for the Work Management Builder



W Work: Management Tutorial V%

Lessen Serdces Help

3. Creating Action Lists
user can perform on & work
package. 7

' You will create an action
list named IMDEXA that 7
allows a user to conlinue o
the next work package or be
prompied for informatien.

This actien list will be an
index action lisi, which
defines only funclion keys.

To create an action list, open
the Action List windaw:

a. Double-click on the Action
Lists ieon displayed in the
work Management Builder -
fcons View window to the

right. .
%> The Action Lists - .

w Previous i Mexistep |

Figure 56. Sample Step Window

The lesson window remains partly visible behind the step, which helps you to maintain
context. When you complete the steps, you return to the lesson window. You can
review the list of steps.

Each step window contains a list of actions for you to perform.

‘ % A step arrow symbol marks descriptions of action results.

2 A note symbol marks notes about performing actions, including relevant syntax or
»

%//////é other conventions.

The step window has Previous and Next step push buttons. Click on the Previous
push button to display the previous step. If you are on the first step, the Previous push
button displays the lesson overview. Click on the Next step push button to display the
next step. If you are on the last step, you can click on the Review lesson push button
to display the lesson overview.

Concepts Windows
The concepts window is displayed when you double-click on a hypertext link in a lesson
window or step window. See Figure 57 on page 96.
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Figure 57. Sample Concepts Window

The concepts window is displayed on the right side of the Work Management Builder
Tutorial window, allowing you to maintain the context of the lesson from which you
selected a concept.

Special terminology is also highlighted in the concepts window, so you can explore
related concepts. Double-click on the highlighted word or phrase to display the related
information. Then press Esc to return to the previous window.

Online help for the tutorial is also displayed in the concepts window. Press F1 to
display online help.

The concepts window has Close, Contents , and Search push buttons. Click on the
Close push button to close the concepts window and return to the Work Management
Builder Tutorial window. Click on the Contents push button to display the contents of
the concepts window in an alphabetical list. You can then choose a concept from the
list. Click on the Search push button to search for certain words.

Closing the Tutorial

To close the tutorial, select Close from the title bar pull-down in the Work Management
Tutorial window. The title bar icon is located in the upper left corner of the Work
Management Tutorial window. All open tutorial windows are closed.
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Appendix B. Defining Function Keys and Options

An action list is composed of functions and options that describe the actions that a user
can perform on a work package. An action list includes only those functions and options
that you want the user to be authorized to perform when the work process is run on
Workfolder Application Facility.

An action list must include, however, every function or option that the user can perform.
For example, if you do not select the Display document option, the user cannot see
the individual documents in a work package.

When you create an action list, you can select different actions that are performed on
the entire work package (with function keys) or on individual documents in the work
package (with options).

¢ When you create an index action list, you select only function keys. See Table 3.

¢ When you create a work action list, you select both function keys and options. See
Table 4 on page 98.

Table 3. Available Choices for Defining an Index Action List

This function

key Lets the user

Continue key Remove the current work package from the current workbasket and
release the work package to continue on to the next step of the current
process.

Exit Return the current work package to the current workbasket. The work
package remains in the current workbasket.

Reassign Remove the current work package from the current workbasket and
assign the work package to a user-specified workbasket.

Cancel Return the current work package to the current workbasket without
sending the current work package on in the work process.

Delete Delete the selected document from the current work process.

User-defined Send information about the current work package to a user exit from

which custom code can be run.

Prompt Display a list of values for the input field, from which the user can select a
value to fill in the input field.

Skip Return the current work package to the current workbasket and move on
to the next work package without sending the first work package on in the
work process. Useful when a user is working with work packages in the
order that the system displays work to the user. Lets the user bypass the
current work package and move on to the next work package.

Retrieve Fill in the values in the input fields with values that the user entered on
the previous display of the same panel.
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Table 4 (Page 1 of 2). Available Choices for Defining a Work Action List

This function
key

Lets the user

Move Move the selected document into either a user-specified case or a file
document cabinet.

Copy Copy the selected document into either a user-specified case or a file
document cabinet.

Delete Delete the selected document from the current work package.
document

Display Display the selected document on the image monitor.

document

Print document

Create a print request for the selected document.

Reindex to Move the selected document to the reindex queue.

queue

Document Display information about the selected document, such as file cabinet

details keywords and document creation date. Available only for file cabinet
documents.

Change Change selected information about the document, such as the current file

document cabinet keywords and document type (for file cabinet documents) and the

current document type (for case documents).

Fax document

Create a fax request for the selected document.

Retrieve
document

Create a request to retrieve the selected document from secondary
storage.

View locations

Display a list of all of the cases and file cabinets in which the selected
document exists.

Work with
versions

List all versions of the selected document.

Edit document

Display the selected document on the image monitor for editing.

Reindex to Move the selected coument to an indexing workbasket that the user
workbasket specifies.

Export Create an export request for the selected document.

document

User-defined
option

Send information about the selected document and the current work
package to a user exit from which custom code can be run.

Continue Remove the current work package from the current workbasket and
release the work package to continue on to the next step of the current
process.

Exit Return the current work package to the current workbasket. The work
package remains in the current workbasket.

Display folder Display all documents in the current folder work package on the image
monitor.

Refresh Clear the current panel of any user input.

Print folder Create a print request for each document in the folder work package.
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Table 4 (Page 2 of 2). Available Choices for Defining a Work Action List

This function
key

Lets the user

Reassign

Remove the current work package from the current workbasket and
assign the work package to a user-specified workbasket.

Search work

Access either case or file cabinet functions without leaving the current
work package.

Begin process

Create a new work package that contains the same information as the
current work package, and to reassign the new work package to a
user-specified process.

Comments Create, change, and delete comments for cases.

Cancel Return the current work package to the current workbasket without
sending the current work package on in the work process.

Release Release a pended work package according to reasons that the user
specifies.

Pend Pend the current work package according to reasons that the user
specifies.

Close Close the folder work package and remove it from the current process.

Add form to Select one form from a list of forms to be added to the current case.

folder

Reverse order

Reverse the displayed order of documents in a folder work package.

View history

Display the historical data that pertains to the current work package.

Export folder

Create an export request for the selected document.

Import to Display panels that allow documents to be imported to the current folder
folder work package.
Fax folder Create a fax request for each document in the current folder work

package.

User-defined

Send information about the current work package to a user exit from
which custom code can be run.

Force continue

Remove the current work package from the current workbasket and
continue the work package to the next predefined step of the process. If
the current work package is located at a collection point, the work
package is started on the exception route defined for that collection point
and the collection point criteria are considered satisfied.

Skip

Rturn the current work package to the current workbasket and move on to
the next work package without sending the first work package on in the
work process. Useful when a user is working with work packages in the
order that the system displays the work to the user. Lets the user bypass
the current work package and move on to the next work package.

Force end

Remove the current work package from the current work process,
regardless of the location of the work package within the work process.
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Glossary

This glossary defines terms and abbreviations used in
this book and the product document library. Refer to the
IBM Dictionary of Computing, ZC20-1699-09, for terms
or abbreviations that do not appear here.

The following cross-references are used in this glossary:

¢ Contrast with. This refers to a term that has an
opposed or substantively different meaning.

e See. This refers the reader to multiple-word terms in
which this term appears.

¢ See also. This refers the reader to terms that have
a related, but not synonymous, meaning.

e Synonym for. This indicates that the term has the
same meaning as a preferred term, which is defined
in the glossary.

A

access list . A list consisting of one or more individual
user IDs or user groups and the privilege set associated
with each user ID or user group. You use access lists to
control user access to items in Visuallnfo for AS/400.
The items that can be associated with access lists are
the data objects stored by users, index classes and
subsets, workbaskets, and workflows.

action list . In Workfolder Application Facility work
management, an approved list of the actions, defined by
a supervisor, that a user can perform on work packages.
An action list defines options, such as printing or
displaying work packages, and the function keys that are
available for use.

active case . A case that was entered and indexed,
assigned to a queue, and has been previously pended,
unqueued, assigned to a process, or assigned to a
workbasket. A case with this status can be accessed
through the Work any case, Work queued case, or
Review any case menu options.

address ID profile . A control file used in Workfolder
Application Facility that contains names and addresses.

ad hoc route . A route that is not part of a defined

Workfolder Application Facility work management
process. An ad hoc route is started when a user creates
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a work package and assigns it directly to a workbasket.
The user manually routes the work package from one
workbasket to another by reassigning it.

administrator . The person responsible for system
management, controls, and security, as well as case
statistics. Synonymous with system administrator.

Advanced Peer-to-Peer Networking (APPN) . Data
communications support that routes data in a network
between two or more APPC systems that are not directly
attached.

advanced program-to-program communications

(APPC). Data communications support that allows
programs on an AS/400 system to communicate with
programs on other systems having compatible
communications support. This communications support
is the AS/400 method of using the SNA LU session type
6.2 protocol.

annotation . An added descriptive comment or
explanatory note.

APAR. Authorized Program Analysis Report.

API. Application programming interface.

application programmer A programmer who designs
programming systems and other applications for a user’s
system.

application program interface (APl) . The
formally-defined programming language interface which
is between an IBM system control program or a licensed
program and the user of the program.

APPC. Advanced program-to-program communications.
APPN. Advanced Peer-to-Peer Networking.

application program interface (APl) . The
formally-defined programming language interface which
is between an IBM system control program or a licensed

program and the user of the program.

archiving . The storage of backup files and any
associated journals, usually for a given period of time.

AS/400. Application System/400.
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AS/400 object directory profile A control file used in
Workfolder Application Facility to identify AS/400 object
directories used for image document storage.

attribute . Used in Visuallnfo for AS/400 APIs, a single
value associated with an item (document or folder). Each
index class can have up to eight attributes.

automatic importing The process that operates in the
background to complete the importing of documents
when it is requested through the facsimile process or the
“set up automatic import only” option.

automatic indexing The indexing process that
operates in the background to complete the indexing of
documents introduced to the system through the scan
and batch index function.

B

binary large object (BLOB)
data treated as a single object.

C

capture . In optical character recognition, to gather
picture data from a field on an input document, using a
special scan.

A large stream of binary

cartridge . (1) A storage device that consists of
magnetic tape, on supply and takeup reels, in a
protective housing. (2) For optical storage, a plastic
case that contains and protects optical disks, permitting
insertion into an optical drive. See also optical disk and
cartridge storage slots.

cartridge storage slots An area in an optical library
where cartridges are stored.

case. A uniquely identifiable work item initiated by a
user. Cases may be: Active (open and being worked),
Pended (suspended awaiting further information), Closed
(processing is complete), New, or Not Queued.

case file . A file that contains one entry for each case.

case history file . A file that contains the history of
actions against each case.

case ID. A system-assigned identifier that is
chronological, based on the time that indexing occurred.
Every case has a unique case ID.

client application An application written with the
Visuallnfo for AS/400 APIs to customize a user interface.

closed case . A case that was closed and cannot be
reopened. A closed case is not assigned to a queue. A
case with this status can be accessed through the
Review any case menu option.

closing a case . Ending a case permanently.
Documents in a closed case may be archived for future
access.

collection . (1) In Visuallnfo for AS/400, a group of
objects with a similar set of storage management rules
and contained within a storage group. Every object is
stored in a collection. (2) In Workfolder Application
Facility, it provides categories for entered documents
and is used to match incoming documents with
outstanding requests. Primarily used in case
processing, collections can also be used when indexing
documents into file cabinets.

collection point In Workfolder Application Facility
work management, the point where work packages wait
for specific events to either occur or become
synchronized before processing can continue. A
collection point is part of a work process. For example,
a collection point is where work packages that are part
of the “open a new account” work process must wait
until credit information is verified. See also decision
point.

collection profile A file that contains one entry for
each type of document to be processed.

content class . A number that indicates the data format
of an object, such as MO:DCA, TIFF, or ASCII.

control files . Files that govern the categories of work
performed by an operator and the types of documents
the system recognizes.

convenience workstation A display workstation
equipped with a printer and a scanner.

cross-system importing The process that imports
cases and documents to one Workfolder Application
Facility system from another.

cross-system exporting The process that exports
cases and documents from one Workfolder Application
Facility system to another.

current document .
processed.

A document that is being
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customization . The process of designing a data
processing installation or network to meet the
requirements of particular users.

D

DASD. Direct access storage device.

DASD system ID profile . A file used to define the
roles of AS/400 processors in the Workfolder Application
Facility system.

DDM. Distributed data management.
DBCS. Double-byte character set.

decision point . In Workfolder Application Facility work
management, the point where work packages continue
on their current route or switch to an alternate route,
depending on the specific information in each work
package. Decision points are tables consisting of
variable names, values, and routes. A decision point is
part of a work process. For example, a decision point is
where work packages that are part of the “open a new
account” work process receive approval or not based on
credit information.

See also collection point.

destager . A function of the object server that moves
objects from the staging area to the first step in the
object’s migration policy or management class.

direct access storage device (DASD) A device in
which access time is effectively independent of the
location of the data.

distributed data management (DDM) A feature of the
System Support Program that lets an application
program work on files that reside in a remote system.

display workstation An image processing workstation
used primarily for displaying documents that have been
previously scanned or imported into the AS/400 system.

document . (1) An item containing one or more base
parts. See also collection point. (2) Information and the
medium on which it is recorded that generally have
permanence and that humans or machines can read.
(3) A named, structural unit of text that can be stored,
retrieved, and exchanged among systems and users as
a separate unit. Also referred to as an object. A single
document can contain many different types of base
parts, including text, images, and objects such as
spreadsheet files.

document content architecture (DCA) . An
architecture that guarantees information integrity for a
document being interchanged in an office system
network. DCA provides the rule for specifying form and
meaning of a document. It defines revisable form text
(changeable) and final form text (unchangeable).

document type . Provides categories for entered
documents and are used to match incoming documents
with outstanding requests. Primarily used in case
processing, document types can also be used when
indexing documents into file cabinets.

document type profile A file that contains one entry
for each type of document to be processed.

document working set A set of document images
selected from a menu that Workfolder Application Facility
provides. This set of document images is sent to the
ImagePlus workstation for display.

double-byte character set (DBCS) A set of
characters in which each character occupies two bytes.
Languages, such as Japanese, Chinese, and Korean,
that contain more symbols than can be represented by
256 code points, require double-byte character sets.
Entering, displaying, and printing DBCS characters
requires special hardware and software support.

E

empty case . A case that has no documents.

export . In Workfolder Application Facility, a process
used to write data from a document in a system folder to
a file. Export and import processes can be used to
transfer documents among Workfolder Application
Facility systems.

F

facsimile configuration profile A control file that lets
the system administrator associate Facsimile Support for
0S/400 with Workfolder Application Facility.

fax exporting . A process that operates in the
background to send documents requested for fax
transmission to a fax server.

fax importing . The importing process that operates in

the background to forward fax documents received by
the fax server.
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FIFO (first in, first out) A queueing technique in
which the next item to be retrieved is the item that has
been in the queue for the longest time.

file cabinet . A component of Workfolder Application
Facility that provides document storage and retrieval
capabilities designed to help manage selected
documents.

file cabinet code . Acts as the file cabinet name.

first in first out (FIFO) A queueing technique in which
the next item to be retrieved is the item that has been in
the queue for the longest time.

focus control . In Workfolder Application Facility, a
feature that lets the system administrator decide whether
Workfolder Application Facility and ImagePlus
Workstation Program or the user controls the active
window.

folder . (1) In Visuallnfo for AS/400, an object that can
contain other folders or documents. (2) In Workfolder
Application Facility, the area in the AS/400 system
where images are stored after successful scanning or
importing.

folder balancing . In the AS/400, the process by which
documents are distributed evenly among the available
folders in the system.

folder manager . In Visuallnfo systems other than
Visuallnfo for AS/400, the term used to describe the data
model and a subset of the APIs. In Visuallnfo for
AS/400, this term refers to the entire set of Visuallnfo for
AS/400 APlIs.

folder name . A 1- to 12-character user-defined word
that names a folder. One period (.) is allowed. If the
folder name is more than 8 characters, the ninth
character must be a period. This can be followed by a 1-
to 3-character extension.

folder path . A folder name, followed by one or more
additional folder names, where each preceding folder is
found. Each folder in the path must be separated by a
slash (/). A folder path can consist of 1 to 63 characters.

forms creation utility A utility that allows the system
administrator to capture a preprinted form as an image
and to define the content and format of the form.

G

Group lll. A compression algorithm that conforms to a
standard promulgated by the International Telegraph and
Telephone Consultative Committee (CCITT).

H

high-speed indexing The indexing process that
operates in the background to complete the indexing of
documents that were input into the system using the
high-speed scanning function.

high-speed scanner workstation A display
workstation equipped with a high-speed scanner.

HTML. Hypertext markup language.

image. (1) A single page of information; the result of
scanning, or digitizing, a single sheet of paper. (2) An
electronic representation of a picture produced by means
of sensing light, sound, electron radiation, or other
emanations from the picture or reflected by the picture.
An image can also be generated directly by software
without reference to an existing picture. See also page
image.

image data. Rectangular arrays of raster information
that define an image. Image data is often created
originally by a scanning process.

image host . The system where scanned and imported
documents are permanently stored. See also optical
library subsystem.

Image Object Content Architecture (IOCA) . A
structured collection of constructs used to interchange
and present images.

image spool file . A file that contains sorted, merged,
and completed print records ready for print.

image workstation . A programmable workstation that
can perform image functions.

import data file . An AS/400 database file that contains
data for one or more documents. Using data in the file,
Workfolder Application Facility creates documents that

can be stored and indexed just like scanned documents.
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importing . A process by which documents are input
into AS/400 using files rather than the scanning process.
Imported documents can be stored in Workfolder
Application Facility on DASD and optical, and displayed
and printed, in the same manner as scanned
documents.

import page ID profile . A file that contains the form
overlay and fields specified for each page ID defined for
a document type whose data type is 01.

inbound . Pertaining to communication flowing in a
direction towards the application program from external
sources, such as a transmission from a terminal to the
application program. Contrast with outbound.

index. To associate a document with a case or
identifier.

index class . A category for storing and retrieving
objects, consisting of a named set of attributes known as
key fields. When you create an item in Visuallnfo for
AS/400, your application must assign an index class and
supply the key field values required by that class. An
index class identifies the automatic processing
requirements and storage requirements for an object.

indexing . The three-step process consisting of viewing
a document, specifying an identifier for the document,
and before creating a new case, or matching the
document with an existing case.

instance . In work management, an occurrence of a
work package within a process. If the process consists
of parallel routes, multiple instances of a work package
exist.

IOCA. Image Object Content Architecture.

item. (1) Set of attributes and objects—one or more
files containing image data, annotations, notes, or other
content—that together represent a physical document,
such as an insurance claim or a folder.

See also document. (2) The smallest unit of information
that the library server administers. An item can be a
folder, document, workbasket, or workflow. Referred to
as an object outside of library server functions.

J

journal . A special-purpose file or data set that can be
used to provide a record of operator and system actions
used to recover data and to identify operator actions that
resulted in a problem.

journaling . (1) The process of recording changes
made in a physical file member in a journal. Journaling
allows you to reconstruct a physical member by applying
the changes in the journal to a saved version of the
physical file member. (2) The process of recording
information sequentially in a database.

K

key field . An attribute of an item that represents a type
of information about that item. For example, a customer
data item might have key fields for the customer’'s name
and social security number.

keyword . A name or symbol that identifies a
parameter.

keyword field . A field enabled for input that provides
data for a single keyword that is defined for a file
cabinet.

keyword value .
keyword.

The input specified in the field for each

L

LAN. Local area network.

language profile . A control file used in Workfolder
Application Facility to define country-specific parameters,
such as time and date formats.

last in first out (LIFO) . A queueing technique in which
the next item to be retrieved is the item most recently
placed in the queue.

library server . The component of Visuallnfo for AS/400
that contains index information for the items stored on
one or more object servers.

LIFO (last in, first out) . A queueing technigue in which

the next item to be retrieved is the item most recently
placed in the queue.

Glossary 107



local area network (LAN) . A computer network located
on a user’s premises within a limited geographical area.

LU 6.2. In Systems Network Architecture (SNA), a type
of session between two application programs in a
distributed processing environment, using the SNA
character string or a structured-field data stream; for
example, an application program using CICS
communication with an AS/400 application.

M

Machine-Generated Data Structure (MGDS) (1) An
IBM structured data format protocol for passing OCR
(Optical Character Recognition) data among various
applications. When workstations use OCR facility to
create coded data from scanned images, those coded
data are formatted into MGDS and passed to other
applications for further processing. (2) Data extracted
from an image and put into generalized data stream
(GDS) format.

magnetic storage . A storage device that uses the
magnetic properties of certain materials.

magnetic tape . A tape with a magnetizable layer on
which data can be stored.

magnetic tape device . A device for reading or writing
data from or to magnetic tape.

masking . The action of obscuring part of the image of
a document so that it is not visible to the viewer.

MGDS. Machine-Generated Data Structure.

Mixed Object: Document Content Architecture
(MO:DCA). An IBM architecture developed to allow the
interchange of object data among applications within the
interchange environment and among environments.

Mixed Object: Document Content
Architecture-Presentation (MO:DCA-P) A subset
architecture of MO:DCA that is used as an envelope to
contain documents that are sent to the ImagePlus
workstation for displaying or printing.

MO:DCA. Mixed Object: Document Content
Architecture.

MO:DCA-P. Mixed Object: Document Content
Architecture-Presentation.

MRI. Machine-readable information.

N

national language support (NLS) The modification or
conversion of a United States English product to
conform to the requirements of another language or
country. This can include enabling or retrofitting of a
product and the translation of nomenclature, MRI, or
product documents.

network . An arrangement of programs and devices
connected for sending and receiving information.

network table file . A text file created during installation
that contains the system-specific configuration
information for each node for each Visuallnfo for AS/400
server. Each server must have a network table file that
identifies it. The name of the network table is always
FRNOLNT.TBL.

new case. A case that was entered and indexed,
assigned to a queue, and has not been previously
pended, unqueued, assigned to a process, or assigned
to a workbasket. A case with this status can be
accessed through the Work any case, Work queued
case, or Review any case menu options.

NLS. National language support.

not queued case . A case that was entered and
indexed, and is not assigned to a queue. A case with
this status can be accessed through the Work any case
or Review any case menu options.

O

object. (1) An item upon which actions are performed.
(2) A collection of data referred to by a single name.
(3) The smallest unit within the system. For ImagePlus
systems, this is typically a single-image document.

(4) Any binary data entity stored on an object server. In
the Visuallnfo for AS/400 data model, object specifically
refers to a document’s contents or parts.

object authority . The right to use or control an object.

object directory . A control file used in Workfolder
Application Facility to identify AS/400 object directories
used for image document storage.

object server . The component of IBM ImagePlus
Visuallnfo for AS/400 that physically stores the objects
or information that client applications store and access.
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OCR. Optical character recognition.

operator . The person who handles daily system
administrative tasks.

optical . Pertaining to optical storage.

optical cartridge . A storage device that consists of an
optical disk in a protective housing. See also cartridge.

optical character recognition (OCR) Character
recognition that uses optical means to identify graphic
characters.

optical disk . A disk that contains digital data readable
by optical techniques. Synonymous with digital optical
disk.

optical drive . The mechanism used to seek, read, or
write data on an optical disk. An optical drive may reside
in an optical library or as a stand-alone unit.

optical drive profile A control file used in Workfolder
Application Facility to define the optical controller used
for the optical storage of documents.

optical libraries . Software used to store image data on
optical platters. Only direct-attached optical systems
contain optical libraries.

optical library subsystem The hardware and software
that provides the long-term storage of the image data.
See also image host.

Optical Storage Support Software that supports
communication between stand-alone optical disk drives,
the optical library, and Visuallnfo for AS/400 and
Workfolder Application Facility. The software runs on the
System/36 5363 unit serving as the optical controller.

optical system profile A file used to define the optical
controller used for the optical storage of documents.

optical systems . Hardware used to store image data
on optical platters. Only direct-attach optical systems
contain optical libraries.

optical volume . One side of a double-sided optical
disk containing optically stored data.

0S/2. Operating System/2.
0S/400. Operating System/400.

outbound . Pertaining to a transmission from the
application program to a device. Contrast with inbound.

output class . A unique name assigned to a specific
time frame when faxes are eligible to be transmitted.

output profile . A file that defines the content of each

output form.

override . A parameter or value that replaces a
previous parameter or value.

P

page. A single physical medium; for example, an
8.5-inch by 11-inch piece of paper.

page image . The electronic representation of a single
physical page. The bounds of a page image are
determined by the electromechanical characteristics of
the scanning equipment, along with the image capture
application specifications in the receiving data
processing system.

page scan . The electromechanical process of scanning
a physical page (paper) to create a hit image of the
page.

pan. Progressively translating an entire display image
to give the visual impression of lateral movement of the
image.

PDF. Portable document format.

pend. To suspend a case while awaiting additional
information or action, such as a particular document type
or date.

pended case . A case that was pended through
casework, waiting for more information. A pended case
is not assigned to a queue. A case with this status can
be accessed through the Work any case or Review any
case menu options.

pending . Awaiting further information or action on a
case.

platter . See optical disk.

prefix . (1) A code dialed by a caller before being
connected. (2) A code at the beginning of a message
or record.

Presentation Text Object Content Architecture

(PTOCA). An architecture developed to allow the
interchange of presentation text data.

Glossary 109



primary processor In a group of processing units, the
main processing unit and its internal storage through
which all other units communicate.

printer workstation
with a printer.

A display workstation equipped

priority . A rank assigned to a task that determines its
precedence in receiving system resources.

privilege . An authorization for a user to either access
or perform certain tasks on objects stored in Visuallnfo
for AS/400. The system administrator assigns privileges.

privilege set . (1) In Visuallnfo for AS/400, collection of
privileges for working with system components and
functions. The system administrator assigns privilege
sets to users (user IDs) and user groups. (2) In the
work management system in Workfolder Application
Facility, an approved list of the actions, defined by a
supervisor, that a user can perform on work packages.
An privilege set defines options, such as printing or
displaying work packages, and the function keys that are
available for use.

process item .
process.

Item used as a building block in a work

profile . A file that governs the categories of work
performed and the types of users recognized by the
system.

program temporary fix (PTF) A temporary solution or
bypass of a problem diagnosed by IBM as resulting from
a defect in a current unaltered release of the program.

PTF. Program temporary fix.

PTOCA. Presentation Text Object Content Architecture.

Q

queue. A line or list of items waiting to be processed;
for example, cases to be worked or messages to be
displayed.

queue ID profile . A file that contains one entry for
each active case. Each case is indexed by queue ID,
gueue type, and creation date and time.

R

reindexing . The process of indexing documents that
were previously indexed incorrectly. This process is the
same as the indexing process.

render. To take data that is not typically image-oriented
and depict or display it as an image. In Visuallnfo for
AS/400, you can render word-processing documents as
images for display purposes.

resolution . In computer graphics, a measure of the
sharpness of the image, expressed as the number of
lines and columns on the display screen or the number
of pels per unit of area.

rotate . A function of the document display window and
the scan document display window. The orientation
depends on the option selected.

route. In work management, a set of steps that move
work between workbaskets, collection points, and
decision points.

S

SBCS. Single-byte character set.

scan overlap . The process by which a document is
scanned while a previously scanned document is stored
on DASD.

scanner . A device that examines a spatial pattern one
part after another and generates analog or digital signals
corresponding to the pattern. (l)

scanner workstation
with a scanner.

A display workstation equipped

scanning . A physical process that enters documents
into an ImagePlus workstation. After a document has
been scanned, it can be stored permanently.

scanning and batch indexing An efficient scanning
and indexing option that overlaps the scanning of a
document with the storing of another document, while an
indexing process operates automatically in the
background.

search criteria . In Visuallnfo for AS/400, the text
string used to represent the logical search to be
performed on the library server.
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secondary processor In a group of processing units,
any processing unit other than the primary unit.

server. On a local area network, a data station that
provides facilities to other data stations; for example, a
file server, a print server, a mail server.

side by side . A function on the document display
window that displays two pages of a multipage
document next to each other.

single-byte character set (SBCS) A set of characters
in which each character occupies one byte.

slot. (1) A position in a device used for removable
storage media. (2) A space in an optical library where
an optical cartridge is stored. See optical cartridge.

SMS. System-managed storage.

spool file . A file that holds output data waiting to be
printed or input data waiting to be processed by a
program. Workfolder Application Facility can convert a
spool file to an import data file.

spool writer . The part of the System Support Program
that prints output saved in the spool file.

staging . The process of moving a stored object from
an offline or low-priority device back to an online or
higher priority device, usually on demand of the system
or on request of a user. When a user requests an object
stored in permanent storage, a working copy is written to
the staging area.

stand-alone . Pertaining to an operation that is
independent of any other device, program, or system.

step number . In work management, the numbers that
specify the order in which route commands are
processed. Each step number must have an associated
command telling the route what action to take.

storage . The action of placing data into a storage
device.

storage class . A storage class, in combination with an
optical system identifier, defines the set of optical
volumes upon which documents can be stored.
Documents with the same storage class and optical
system ID are stored on the same optical volume.

storage method . In Workfolder Application Facility, a
means of grouping documents together for storage to an
optical disk. Workfolder Application Facility provides the

following storage methods: file cabinet, collection,
prioritized, and system assigned (optical distribution).

storage system . A generic term for storage in
Visuallnfo for AS/400.

subsystem . A secondary or subordinate system, or the
programming support part of a system that is usually
capable of operating independently of or asynchronously
with a controlling system.

suspend a case . To end case processing temporarily.

system administrator The person who manages the
ImagePlus workstation, the Optical Library Subsystem,
and the departmental processor. The system
administrator helps with problem determination and
resolution. Synonymous with administrator.

system ID profile . A control file used in Workfolder
Application Facility to define the roles of AS/400
processors in the system.

system-managed storage (SMS) . The Visuallnfo for
AS/400 approach to storage management. The system
determines object placement, and automatically
manages object backup, movement, space, and security.

System Support Program (SSP) A group of
IBM-licensed programs that manage the running of other
programs and the operation of associated devices, such
as the display station and printer. The SSP also contains
utility programs that perform common tasks, such as
copying information from diskette to disk.

T

tape. See magnetic tape.

tape cartridge .

U

user. (1) Anyone requiring the services of Visuallnfo
for AS/400. This term generally refers to users of client
applications rather than the developers of applications,
who use the Visuallnfo for AS/400 APIs. (2) In
Workfolder Application Facility, the individual who
performs input and case processing.

See cartridge.

user activity file . A file that contains one entry for
each user. It contains item counts and productivity
statistics.
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user exit . (1) A point in an IBM-supplied program at
which a user exit routine may be given control. (2) A
programming service provided by an IBM software
product that may be requested during the processing of
an application program for the service of transferring
control back to the application program upon the later
occurrence of a user-specified event.

user exit routine . A routine written by a user to take
control at a user exit of a program supplied by IBM.

user fields . Data fields defined within the user exit
programs. The user exit programs process the data and
values passed into these fields.

user ID profile . A file that contains one entry for each
user. The entries contain information such as processing
eligibility.

Vv

volume . A certain portion of data, together with its data
carrier, that can be handled conveniently as a unit.

W

workbasket . In work management in Workfolder
Application Facility for AS/400, a container that holds
work packages. Workbaskets can be used as parts of
process definitions or ad-hoc routes. In Visuallnfo for
AS/400, a logical location within the Visuallnfo for
AS/400 system to which work packages can be assigned
to wait for further processing.

A workbasket definition includes the rules that govern
the presentation, status, and security of its contents.

workbasket privilege set A list that specifies which
options and function keys operate on indexing and work
with work package panels.

work management . A system that lets an enterprise
define a work process and environment to automate
workflow and control business processes.

work management case . A case that was entered and
indexed, and has been assigned to either a process or a
workbasket. A work management case is not assigned
to a queue. A case with this status can be accessed
through the Review any case, Work with workbaskets, or
Search for work packages menu options.

work order . The sequence of work packages in a
workbasket.

work package . The work that is routed from one
location to another. A work package can consist of an
unindexed document, a file cabinet document, a
Workfolder Application Facility case, or a user-defined
collection of objects. It can also be empty, such as when
you first create it and before it contains any work items.
Work packages can be routed automatically by defined
processes, or users can manually route work packages
in an ad-hoc manner to workbaskets they specify.

work process . In work management, the series of
steps, events, and rules through which a work package
flows. A work process is a combination of the route,
collection point, and decision point through which a
predefined type of work package must progress.

workflow . A sequence of workbaskets that a document
or folder travels through while it is being processed.

working set . A set of pages residing in the workstation,
which can constitute one or more documents.

workstation . A computer processor unit, image display
unit, scanners, and printers with which the user performs
input, indexing, and printing.
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Index

A

action list
browsing 40
checking in 28
checking out from a container window 28
checking out from an object window 28
closing 41
copying 30
creating 37
definition 3, 36
deleting 31
displaying a list of checked-out action lists 34
function keys 36
functions and options 38
modifying 39
naming 37
opening 27
options 36
printing 31
releasing 32
renaming 30, 39
resolving name conflicts 29
selecting a type 37
updating 39
using 3
Action List window 37
Action Lists container window 36
actions, tutorial 93
assign value node
definition 58
describing 74
restrictions 62
selecting a variable 75
Assign Value window 75

B

begin node
definiton 57
describing 66
restrictions 62
Begin Node window 66
bend points 65
BookManager (softcopy) for this book vii
browsing an object
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browsing an object (continued)
action lists 40
work processes 54
workbaskets 49

C

changing an object
action lists 39
work processes 53
workbaskets 48
checking in an object
action lists 28
check-in push button 39, 40, 47, 49
updated objects 35
work processes 28
workbaskets 28
checking out an object
action lists 28
check-out push button 39, 40, 48, 49
displaying a list of checked-out objects 34
from an object container window 28
from an object window 28
work processes 28
workbaskets 28
clearing a node 63
clipboard
displaying the contents 64
Clipboard View window 86
clipboard, displaying the contents 64, 86
closing an object
action lists 41
work processes 55
workbaskets 50
Collection Point Event List window 71
collection point node
definition 58
describing 70
restrictions 62
Collection Point window 70
collection points 51
concepts window, tutorial 95
CONFIG.SYS file, changing 10
connecting nodes, restrictions 61
connector
adding a bend 65



connector (continued)
cancelling 63
creating 57, 60
definition 58
moving a bend 65
part of a work process diagram 56
specifying additional information 60
collection point connector 71
decision point connector 69
types 58
using 57
container windows
See object container windows
copying an object 30
creating
connector 57, 60
graphical work process 53, 63
node 59
objects
action lists 37
work processes 52
workbaskets 42

D

data, loading 23
decision branch connector
definition 59
describing 69
selecting 69
Decision Branch window 69
decision point node
definition 57
describing 68
restrictions 62
Decision Point window 68
decision points 51
Define Grid window 87
Define Overview Refresh Rate window 85
Define Paper Size window 83
deleting an object 31
deleting Work Management Builder
selecting the components to delete 17
stopping the delete 18
desktop 21, 90
directional connector 59
directories, specifying 11
disk space, checking available 12
displaying
grid 87

displaying (continued)

objects, included 33
document node

definition 58

describing 72

restrictions 62

selecting a document type 73
document types 45
Document window 73
drawing surface 56, 87
drawing surface, changing size 82

E

editing action, reversing 63
editing modes
browse 25, 40, 49, 54
create 25, 37, 42, 52
update 25, 39, 48, 53
editor, graphic
See work process editor
event list 72
exception branch for a collection point
definition 59
describing 71
exception branch for a decision point 59

F

files, overwriting 11

filtering the view 33
function keys 3

functions and options list 38
functions list 37

G

graphic editor
See work process editor
graphical work process, creating 53, 63

grid 87
centering the nodes 87
displaying 87

H

handles, size 65
hardware requirements 7
history log 43
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host connection, working with 24
HTML (softcopy) for this book vii
hypertext links 92

icons
action lists 36
checked out 20
in-use emphasis 20
new object 20
unnamed 39, 48, 55
work process 51
workbasket 42

Include window 33

information flow 3

installation requirements
hardware 7
software 7

installing Work Management Builder
checking available disk space 12
checking delete progress 17
checking installation progress 13
overwriting files 11
selecting the components to install 11
specifying directories 11
specifying paths 12
updating the CONFIG.SYS file 10

L

landscape orientation, work process diagram 83
lesson window, tutorial 93
lessons, tutorial 93
line-of-business 51, 57, 66
Loading Data window 23
local mode 22, 24, 25
logging
history 43
user activity 44
logging on to Workfolder Application Facility 23
logging off Workfolder Application Facility 25

M

Match Collection Point APl 58, 74
modifying an object
See changing an object

N

name conflicts, resolving 29
naming an object
action lists 37
work processes 76
workbaskets 43

node
cancelling 63
clearing 63

connecting, restrictions 61
creating 57, 59
definition 59
manipulating 63
copying 64
moving 63
scaling 64
part of a work process diagram 56
specifying additional information 59
text label 59
types
assign value node 58
begin node 57
collection point node 58
decision point node 57
document node 58
stop node 58
user exit node 57
user-defined event node 58
work node 57
using 57

O

object container windows
Action Lists container window 36
checking in an object 29
checking out an object 28
definition 26
displaying a list of checked-out objects 34
example 26
filtering the view 33
opening 26, 27
Work Processes container window 51
Workbaskets container window 42
objects
See Work Management Builder objects
opening an object 27
opening an object container window
Action Lists container window 36

Index
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opening an object container window (continued)
Work Processes container window 51
Workbaskets container window 42

opening Work Management Builder 21

options 36

orientation, work process diagram 83

0S/2 desktop 21, 90

Overview window

adjusting the view in the Work Process window 85

closing 85

displaying 84

refreshing 84
overwriting files 11

P

parallel connector 59
parallel processing 59
path information, work process diagram 57
path, work process 51, 59
PDF (softcopy) for this book vi
planning a work process
defining action lists 3, 36
defining work packages 2
defining work processes 3, 51
defining workbaskets 2, 42
portrait orientation, work process diagram 83
Print Diagram window 82
Print window (object) 32
Print Work Process window 81
printing
object 31, 81
work process diagram 80
profile, user 84, 85, 87
progress indicator 13, 23, 78
progress, checking
delete 17

Q

queue
definition 58
describing 75

R

reassigning a work package 44
releasing an object 32
Rename window 29

renaming an object

action lists 39

work processes 53

workbaskets 48
requirements

hardware 7

software 7
resetting the tutorial 92
restrictions on connecting nodes 61, 77
reversing an editing action 63
revising an object

See changing an object

S

Save Work Process As window 80
Save Work Process window 79
scaling, work process diagram 86
scanner 66
security code level 43
size handles 65
softcopy for this book
BookManager format vii
HTML format vii
PDF format vi
softcopy format for this book vi
software requirements 7
source node 58
starting Work Management Builder 21
status area 34
step window, tutorial 94
steps, tutorial 93
stop node
definition 58
restrictions 62
Stop Node window 76
symbols, in the work process editor 59

T

target node 58
text label 59
Tool Palette window 57
using nodes and connectors 57
tutorial
concepts window 95
features 89
hypertext links 92
interacting with Work Management Builder
lesson window 93
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tutorial (continued)
resetting 92
starting the tutorial 91
step window 94

U

undoing an editing action 63
updating an object
See changing an object
user activity log 44
user exit 51, 58, 68
user exit node
definition 57
describing 68
restrictions 62
User Exit window 68
user profile 84, 85, 87
user-defined event node
definition 58
describing 73
restrictions 62
User-defined Event window 74

Vv

variable, selecting 75
Verify window 78

verifying a work process 77
view, filtering 33

viewing frame, adjusting 85

W

windows, list of Work Management Builder
Action List 37
Action Lists container 36
Assign Value 75
Begin Node 66
Clipboard View 86
Collection Point 70
Collection Point Event List 71
Decision Branch 69
Decision Point 68
Define Grid 87
Define Overview Refresh Rate 85
Define Paper Size 83
Document 73
Include 33
Loading Data 24

windows, list of Work Management Builder (continued)

Overview 84
Print (object) 32, 82
Print Work Process 81
Rename 29
Save Work Process 79
Save Work Process As 80
Stop Node 76
Tool Palette 57
User Exit 68
User-defined Event 74
Verify 78
Work Management Builder 26
Work Management Builder Logon 23
Work Node 67
Work Process 52
Work Process Details 77
Work Processes container 51
Workbasket 43
Workbaskets container 42
windows, object container
See object container windows
windows, working with
window components
status area 34
workbaskets 42
Work Management Builder
action lists 36
local mode 25
work processes 51
Work Management Builder Logon window 23
Work Management Builder objects
asicons 36,42, 51
browsing 25, 54
checking in 28
from a container window 29
from an object window 29
updated objects 35
checking out 28
copying 30
creating 25
deleting 31
opening 27
opening more than one object 28
opening one object 27
printing 31
releasing 32
renaming 30
updating 25

Index
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Work Management Builder window 26
work node
definition 57
describing 66
restrictions 62
selecting a workbasket 67
selecting an action list 67
Work Node window 67
work order 46
work package 3, 36, 51
work package, reassigning 44
Work Process Details window 77
work process diagram
creating 57
definition 56
work process editor
adjusting the view 85
changing the size of the drawing surface 82
component windows 56
Clipboard View window 86
Overview window 84
Tool Palette window 56
Work Process window 56
displaying a grid 87
zooming in and out 86
Work Process window 52
work process, planning
See planning a work process
work processes
browsing 54
checking in 28
checking out from a container window 28
checking out from an object window 28
closing 55
collection points 3, 51
connectors 53
copying 30
creating 52
decision points 3, 51
definition 3, 51

deleting 31

displaying a list of checked-out work processes 34
naming 76

nodes 53

opening 27

paths 3, 51

printing

graphical representation 81
text translation 80

textual contents 31

work process diagram 81

work processes (continued)
releasing 32
renaming 30, 53
resolving name conflicts 29
saving
with a different name 80
with its current name 79
updating 53
using 3
verifying 77
Work Processes container window 51
workbasket type, selecting 44
Workbasket window 43
workbaskets
assigning function keys 44
browsing 49
checking in 28
checking out from a container window 28
checking out from an object window 28
closing 50
copying 30
creating 42
definition 2, 42
deleting 31
describing 43
displaying a list of checked-out workbaskets 34
naming 43
opening 27
printing 31
priority 47
releasing 32
renaming 30, 48
resolving name conflicts 29
selecting a type 44
updating 48
using 2
workbasket icon 42
Workbaskets container window 42
Workfolder Application Facility, using Work Management
Builder with
creating a graphical work process 4
defining a screen prompt 38
deleting an object 31
function keys 38
identifying a work process 76
logging off 25
logging on 23
logging user activity 44
options 38
renaming an object 39, 48, 53
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Workfolder Application Facility, using Work Management
Builder with (continued)
software requirements 8
working in local mode 24
working with a host connection 24

Z

zooming in and out 56, 85, 86
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